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บทนํา 
 ในปจจุบัน  อุปกรณ ไมโครคอนโทรลเลอรไดพัฒนาไปเร็วมากดังจะเห็นไดจากการที่ มีไมโคร
คอนโทรลเลอรหลายตระกูลออกมาวางขายในทองตลาด และผูผลิตไมโครคอนโทรลเลอรเหลานี้ตางก็ได
พยายามพัฒนาขีดความสามารถในการทํางานของไมโครคอนโทรลเลอรของตนเองใหมีมากขึ้น ทั้งในดานการ
เพิ่มความเร็วของ CPU การเพิ่มฟงกชั่นการทํางานภายในใหมีมากขึ้น ในขณะที่ไมโครคอนโทรลเลอรบางเบอร
จะถูกออกแบบมาเพื่อใหผูใชงานสามารถเขียนโปรแกรมไดงายขึ้นดวย ซึ่ง AVR ไมโครคอนโทรลเลอรก็เปน CPU 
อีกตระกูลหนึ่งที่เปนที่นิยมนํามาใชงานในปจจุบัน เพราะมันเปนไมโครคอนโทรลเลอรที่มีทั้งความเร็วและการ
ออกแบบโครงสรางภายในที่เปนระเบียบทําใหผูใชงานสามารถเขียนโปรแกรมไดงาย 
 ทางบริษัท อีทีที จํากัด ไดออกแบบบอรด AVR ไมโครคอนโทรลเลอรขึ้นมาใหม 3 รุนดวยกันซึ่ง
ประกอบไปดวย  CP-AVR V3.0, CP-AVR V3.0 EXP และ  CP-AVR V4.0 ซึ่งรายละเอียดของบอรดไมโคร
คอนโทรลเลอรแตละรุนทานสามารถศึกษาไดจากเนื้อหาภายในของคูมือเลมนี้ โดยบอรดไมโครคอนโทรลเลอร 
ทั้ง 3 รุนนี้สามารถใชไดกับ AVR ไมโครคอนโทรลเลอรเบอร AT90S8535 หรือ ATmega163 หรือเบอรอื่น ที่มี
ตําแหนงขาของอุปกรณที่ตรงกันเชนเบอร ATmega323 เปนตน  

ในการพัฒนาโปรแกรมสําหรับผูเริ่มตนนั้น ทานสามารถศึกษาโปรแกรมตัวอยางไดจากแผน CD-ROM 
ที่ทานจะไดรับเมื่อทานซื้อบอรด AVR ไมโครคอนโทรลเลอร ซึ่งโปรแกรมตัวอยางเหลานี้จะถูกเขียนขึ้นดวยภาษา
แอสเซมบลีโดยใชโปรแกรม Astudio4 และเขียนดวยภาษาเบสิกโดยใชโปรแกรม BASCOM นอกจากนั้นแลวใน
แผน CD-ROM นี้ยังบรรจุโปรแกรม ASSEMBLER โปรแกรมสําหรับดาวนโหลดขอมูล Datasheet และโปรแกรม
อื่นๆ ที่จําเปนตอการพัฒนางานของทานไวดวย 
    
        พฤศจิกายน 2002 
        ทีมงาน อีทีที 
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สารบัญ 
เรื่อง          หนา 

- ลักษณะโดยทั่วไป         1 
- แหลงจายไฟ          1 
- การใชงานพอรตของ CPU เปน I/O Port (Input/Output Port)     5 
- การใชงานขั้วตอ PB(KBI)         6 
- การใชงานขั้วตอ PA(ADC)         7 
- การใชงานขั้วตอ I2C IN/OUT        7 
- การใชงานขั้วตอ I2C BUS EXPAND        8 
- การใชงานเครื่องอานบัตรแถบแมเหล็ก (MAGNETIC-CARD READER)    8 
- การใชงาน OUTPUT RELAY        9 
- การใชงานลําโพงขนาดเล็ก หรือ BUZZER       10 
- การใชงานจอแสดงผลแบบ LCD (Dot-Matrix Character LCD)     10 
- การเชื่อมตอกับอุปกรณ I2C BUS        12 
- การใชงาน Interrupt ของอุปกรณ I2C       13 
- แอดเดรสของอุปกรณ I2C         13 
- การใชงาน I2C RTC เบอร PCF8583        14 
- การใชงานหนวยความจํา EEPROM (24XX)       16 
- การใชงาน I/O Port แบบ I2C (PCF8574/A)       17 
- การใชงานพอรตส่ือสารอนุกรม SPI/RS232/RS422/RS485     19 
- การสื่อสารอนุกรม SPI         19 
- การสื่อสารอนุกรมแบบ RS232        20 
- การสื่อสารอนุกรมแบบ RS422        22 
- การสื่อสารอนุกรมแบบ RS485         23 
- การกําหนด Jumper สําหรับการสื่อสารแบบ RS422/485     24 
- การใชงานโปรแกรม w95s8535v5 และ w95mega163v1 สําหรับดาวนโหลดขอมูล   26 
- แนะนําการใชโปรแกรม Astudio4 (AVR assembler)      30 
- วงจรของบอรด CP-AVR V3        36 
- วงจรของบอรด CP-AVR V4        37 
- วงจรของบอรด CP-AVR V4 ตอ        38 
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CP-AVR 
ลักษณะโดยทั่วไป 
 บอรดไมโครคอนโทรลเลอร CP-AVR รุน CP-AVR V3.0, CP-AVR V3.0 EXP และ CP-AVR V4.0 
สามารถใชไดกับไมโครคอนโทรลเลอรตระกูล AVR เบอร AT90S8535 และ ATmega163 โดยจะทํางานที่
ความถี่สูงสุด 8 MHz ลักษณะของบอรดไมโครคอนโทรลเลอรในกลุม CP-AVR นี้ จะแบงออกเปน 3 รุน ใหผูใช
ไดเลือกใชงานกันตามความเหมาะสมดังนี้คือ 

- CP-AVR V3.0 เปนบอรดไมโครคอนโทรลเลอร ซึ่งออกแบบวงจรเฉพาะสวนพื้นฐานที่จําเปน เชน 
แหลงจายไฟ วงจรรีเซ็ต วงจรกําเนิดความถี่สัญญาณนาฬิกา วงจรสําหรับ Download โปรแกรม 
และวงจรสื่อสารอนุกรม สวนวงจร I/O ภายนอกนั้น จะไมไดจัดเตรียมไวใหดวย แตจะทําการตอ
สัญญาณ I/O ตางๆจาก CPU มาไวยังขั้วตอ Connector สําหรับใหผูใชนําไปเชื่อมตอกับอุปกรณ 
I/O ภายนอกไดโดยงาย และยังมีพื้นที่เอนกประสงคสําหรับใหผูใชออกแบบวงจร I/O และตอวงจร 
I/O เพิ่มเติมไดเอง เหมาะสําหรับผูใชที่ตองการนําบอรดไปใชพัฒนางานตนแบบโดยการสราง I/O 
ตางๆขึ้นมาใชงานเอง 

- CP-AVR V3.0 EXPANSION จะมีลักษณะเดียวกันกับบอรด CP-AVR V3.0 แตจะมีแผง Photo 
Board สําหรับใหผูใชตอทดลองวงจร I/O อยางงายๆไดเอง เหมาะสําหรับผูใชที่ตองการศึกษา
เรียนรูและตองการทดลองวงจร I/O ตางๆ รวมกับ CPU อยางงายๆ 

- CP-AVR V4.0 เปนบอรดไมโครคอนโทรลเลอรที่มีการออกแบบวงจรสําหรับเชื่อมตอกับอุปกรณ 
I/O ภายนอกอื่นๆที่มีความจําเปนไวรองรับการใชงานในลักษณะตางๆ เพื่อใหผูใชงานสามารถนํา
บอรดไปใชงานในลักษณะงานที่แตกตางกันได โดยไมตองดัดแปลงวงจร หรือ อาจดัดแปลงวงจร
เพียงเล็กนอยสําหรับงานบางอยาง ซึ่งบอรดรุนนี้เหมาะสําหรับกลุมผูที่ตองการนํา บอรดไมโคร
คอนโทรลเลอรไปใชงานจริงๆแตไมสะดวกที่จะสรางบอรดเอง 

 
แหลงจายไฟ (POWER SUPPLY) 
 สําหรับแหลงจายไฟของบอรดในกลุม CP-AVR นั้น จะสามารถตอใชงานไดทั้งกับไฟกระแสตรงและ
กระแสสลับ  เนื่ องจากในบอรดไดจัดเตรียมวงจร  RECTIFIER แบบ  BRIDGE พรอมวงจร FILTER และ 
REGULATOR ขนาด +5V ไวใหอยางครบถวนอยูแลว โดยผูใชสามารถปอนแรงดันไฟตรงหรือไฟสลับที่มีระดับ
แรงดันประมาณ 9-12V ใหกับบอรด โดยสามารถเลือกตอกับขั้ว CONNECTOR แบบ CPA ขนาด 2 ขา หรือจะ
ตอผานขั้ว CONNECTOR สําหรับ ADAPTER จายไฟก็ไดเชนกัน โดยการทํางานของแหลงจายไฟจะมี LED 
“PWR” สําหรับแสดงผลการทํางานใหทราบดวย 
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            รูปแสดง บอรดไมโครคอนโทรลเลอรรุน CP-AVR V3 
 
 
 
 
 
 
 
 
 
 
   รูปแสดง บอรดไมโครคอนโทรลเลอรรุน CP-AVR V3 EXP 

 
 
 
 
 
 
 
 
 
 

 
     รูปแสดง บอรดไมโครคอนโทรลเลอรรุน CP-AVR V4 
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รูปแสดง ลักษณะของบอรด CP-AVR V3 / AVR V3 EXP 
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      รูปแสดง ลักษณะของบอรด CP-AVR V4 
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การใชงานพอรตของ CPU เปน I/O Port (Input/Output Port) 
 ลักษณะการตอขาพอรตของไมโครคอนโทรลเลอร (MCU) เขากับพอรต I/O ขนาด 34 
ขา(72IOZ80)สามารถแสดงไดดังรูปตอไปนี้ ซึ่งบอรดทั้งสามรุนจะตอในรูปแบบเดียวกัน 
     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปแสดง ลักษณะของการจัดเรียงสัญญาณของขั้ว 34PIN 
 

 โดยปกติพอรต I/O ของ AVR สามารถรับกระแส sink ไดประมาณ 20 mA ดังนั้นเราจึงสามารถนํา
พอรตเหลานี้ไปขับ LED ใหทํางานได ในการใชงานพอรตของ AVR เปน Input/Output Port เราจะตองทําการ
กําหนดทิศทางของพอรตวาจะใหเปนอินพุตหรือเปนเอาพุตโดยการเซตหรือเคลียรคาในรีจิสเตอร DDRx และถา
เราตองการกําหนดระดับของสัญญาณ(high/low)ในขณะที่ PORTx ทํางานในโหมด output เราก็สามารถทําได
โดยการไปset หรือ clear คาในรีจิสเตอร PORTx สวนในกรณีที่พอรตทํางานในโหมด input นั้นถาหากเรามีการ
ตอ R pull low ภายนอกไว และทําการ Set พอรตที่ตอ R Pull Low ใหเปน 1 (Enable Internal Pull Up) พอรต
นั้นจะสามารถจายกระแสออกมาใหกับR ที่ตอ Pull Low ภายนอกไดดวยกระแสประมาณ 20 mA  

ในการอานคาของสัญญานจากภายนอกนั้น ถาเราอานจากรีจิสเตอร PORTx เราจะไดคาที่ถูก Latch  
คางไว ซึ่งเปนคาที่เกิดกอนหนาที่เราจะทําการอาน แตถาเราอานจากรีจิสเตอร PINx เราจะไดคาที่เปนจริงที่เกิด
ขึ้นที่ขาพอรตขณะที่เราทําการอาน ตารางตอไปนี้จะเปนรูปแบบการกําหนดคาเพื่อใหพอรตทํางานในโหมด I/O  

 

PB0
PB2
PB4

PB6
PA0
PA2
PA4
PA6
PC0
PC2
PC4
PC6
+5V
GND
PD2
PD4
PD6

PB1
PB3
PB5
PB7
PA1
PA3
PA5
PA7
PC1
PC3
PC5
PC7
NC
RES
PD3
PD5
PD7
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DDxn PORTxn I/O Pull up Comment 

0 0 Input No Tri-state (Hi-Z) 
0 1 Input Yes Pxn will source current if ext. pulled low 
1 0 Output No Push-Pull Zero output 
1 1 Output No Push-Pull One output 

หมายเหตุ : x คือพอรต A – D, n คือบิต 0 – 7 
 
ตารางแสดง การกําหนดคาใหกับพอรตของไมโครคอนโทรลเลอรตระกูล AVR เพื่อเลือก
โหมดการทํางาน 
 
การใชงานขั้วตอ PB(KBI) 
 พอรต PB(KBI) ถูกจัดไวที่ขั้ว Connector ขนาด 10 PIN แบบ IDE ซึ่งขั้วตอนี้จะมีอยูเฉพาะ ในบอรด 
รุน CP-AVR V4.0 เทานั้น โดยขั้วตอนี้จะเชื่อมตอสัญญาณมาจาก PORTB ของ MCU ทั้ง 8 เสน โดย PB0-PB6 
จะถูกนํามาจัดเรียงไวโดยตรงอยูแลว สวน PB7 จะตองเลือกจาก Jumper (4x4/SPK)  อีกครั้งหนึ่ง โดยลักษณะ
ของขาสัญญาณที่จัดเรียงไวที่ขั้ว PB(KBI) จะเปนดังรูป 

 

 
 
 
 
 
 
 

รูปแสดง ลักษณะของการจัดเรียงสัญญาณของขั้ว PB(KBI) 
 

 โดยจุดประสงคในการออกแบบของบอรด CP-AVR V4.0 นั้น ขั้วตอ PB(KBI) จะใชสําหรับใหผูใช
เชื่อมตอกับวงจรคียบอรดแบบ Matrix ซึ่งสามารถจะใชไดกับคียบอรดแบบ Matrix ขนาด 4x3 หรือ 4x4 ก็ได ซึ่ง
ในกรณีที่ใชกับคียบอรดขนาด 4x3 จะเหลือสัญญาณไว 1 เสนคือ PB7 ซึ่งสามารถนําไปใชควบคุมการกําเนิด
เสียงของลําโพงขนาดเล็กหรือ BUZZER เพื่อกําเนิดเสียงได 

สําหรับในกรณีที่ไมมีความจําเปนตองใชงานคียบอรดแลว ขั้วตอ PB(KBI) นี้ก็ยังสามารถนําไปตอใช
งานเปน Input หรือ Output ทั่วๆไปไดอีกดวย โดยจากวงจรทานจะพบวาเราไดตอ LED เขากับขา PB0 ดังนั้น
หากทานไมใชงานคียบอรดทานสามารถใชงาน LED TEST ตัวนี้ไดโดยการ Short Jumper PB0 สําหรับบอรดไม
โครคอนโทรลเลอร CP-AVR V3.0/V3.0 EXP หรือ Short Jumper PA0 สําหรับบอรดไมโครคอนโทรลเลอร CP-
AVR V4.0   

 

PB0
PB2
PB4
PB6

+VCC

PB1
PB3
PB5
PB7
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การใชงานขั้วตอ PA(ADC) 
 พอรต PA(ADC) นี้จะถูกเชื่อมตอออกมารอไวยังขั้ว Connector ขนาด 10 PIN แบบ IDE ซึ่งขั้วตอนี้จะ
มีอยูเฉพาะบอรดในรุน CP-AVR V4.0 เทานั้น โดยขั้วตอ PA(ADC) นี้ สามารถโปรแกรมหนาที่การใชงานได 
หลายหนาที่ เชน โปรแกรมใหทําหนาที่เปน ADC ขนาด 10 บิต 8 ชอง เพื่อรับคาสัญญาณ Analog ขนาด 0-
5VDC จากภายนอกเขามาและเปลี่ยนเปนคาขอมูลดิจิตอล (000H-3FFH) ใหกับ CPU นําไปประมวลผลตาม
ตองการ หรือถาไมตองการใชงานเปน ADC พอรต PA(ADC) นี้ก็ยังสามารถโปรแกรมหนาที่การทํางานสําหรับใช
งานเปน Input / Output ทั่วไปไดอีกดวย โดยลักษณะของขาสัญญาณที่จัดเรียงไวที่ขั้ว PA (ADC) จะเปนดังรูป 

 

 
 
 
 
 
 

รูปแสดง ลักษณะของการจัดเรียงสัญญาณของขั้ว PA(ADC) 
 

นอกจากนี้แลวขา PA7 ในกรณีที่ไมตองการใชงานเปน ADC สามารถนําไปใชงานเปน Output สําหรับ
ควบคุมการทํางานของ RELAY ไดอีกดวย โดยการ Short Jumper PA7(RELAY) ไว 
 
การใชงานขั้วตอ I2C IN/OUT 
 พอรต I2C IN/OUT นี้จะถูกเชื่อมตอออกมารอไวยังขั้ว Connector ขนาด 10 PIN แบบ IDE ซึ่งขั้วตอนี้
จะมีอยูเฉพาะบอรดในรุน CP-AVR V4.0 เทานั้น โดยขั้วตอ I2C IN/OUT นี้ จะเชื่อมตอมาจากขาสัญญาณ I/O 
Port ของ PCF8574/A ซึ่งสามารถโปรแกรมหนาที่การใชงาน ใหเปน Input หรือ Output ก็ไดตามตองการจาก
โปรแกรม แตตองกําหนดหนาที่ใหเปน Input หรือ Output อยางใดอยางหนึ่งเทานั้น ไมสามารถใชงานทั้งสอง
หนาที่พรอมๆกันได และในการกําหนดหนาที่ใหเปน Input หรือ Output ก็ตองกําหนดใหเหมือนกันทั้ง 8 บิต ดวย 
โดยลักษณะของขาสัญญาณที่จัดเรียงไวที่ขั้ว I2C IN/OUT จะเปนดังรูป 

 

 
 
 
 
 
 

รูปแสดง ลักษณะของการจัดเรียงสัญญาณของขั้ว I2C IN/OUT 
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การใชงานขั้วตอ I2C BUS EXPAND 
 พอรต I2C BUS EXPAND นี้จะถูกเชื่อมตอออกมารอไวยังขั้ว Connector ขนาด 10 PIN แบบ IDE ซึ่ง
ขั้วตอนี้จะมีอยูเฉพาะบอรดในรุน CP-AVR V4.0 เทานั้น โดยขั้วตอ I2C BUS EXPAND นี้ จะใชสําหรับทําการ
ขยายหรือเพิ่มเติมจํานวนอุปกรณที่ใชการติดตอส่ือสารแบบ I2C ใหกับบอรด  

 

 
 
 
 
 
 
 

รูปแสดง ลักษณะของการจัดเรียงสัญญาณของขั้ว I2C BUS EXPAND 
 

การใชงานเครื่องอานบัตรแถบแมเหล็ก (MAGNETIC-CARD READER) 
 สําหรับบอรด CP-AVR V4.0 นั้น จะออกแบบใหสามารถเชื่อมตอกับเครื่องอานบัตรแถบแมเหล็กรุน 
“MCR-B02TTL” ไดโดยตรง โดยไมตองดัดแปลงวงจรใดๆทั้งส้ิน โดยในบอรดจะจัดเตรียมขั้วแบบ CPA ขนาด 5 
PIN ไวรองรับอยูแลว ผูใชสามารถนําขั้วตอของเครื่องอานบัตรแถบแมเหล็ก รุน “MCR-B02TTL” ของบริษัท อีที
ที ตอเขาไปไดทันที สําหรับในการเขียนโปรแกรมเพื่อเชื่อมตอระหวางบอรด CP-AVR V4.0 กับเครื่องอานบัตร
แถบแมเหล็กนั้น จะสามารถทําได 2 แบบ คือ ใชวิธีการวนรอบตรวจสอบสัญญาณจากเครื่องอานบัตรแถบแม
เหล็กเอง ซึ่งวิธีการนี้จะใชสัญญาณจาก CPU เพียง 2 เสนสัญญาณคือ PD4 ทําหนาที่เปน DATA และ PD5 ทํา
หนาที่เปน CLOCK โดยตองกําหนดคุณสมบัติของสัญญาณทั้ง 2 เสนใหมีทิศทางเปน Input และควร ENABLE 
การ PULL-UP ของสัญญาณทั้ง 2 นี้ดวยเสมอ สวนอีกวิธีหนึ่งคือการใชวิธีการ Interrupt ซึ่งสามารถทําไดโดย
การ SHORT JUMPER “INT1” ที่อยูใกลๆกับขั้วตอเครื่องอานบัตรแถบแมเหล็ก ซึ่งการ SHORT JUMPER จะ
เปนการเชื่อมตอสัญญาณ INT1 ของ CPU เขากับ สัญญาณ PRESENT ของเครื่องอานบัตรแถบแมเหล็ก ดังนั้น
เมื่อมีการนําบัตรแถบแมเหล็กไปรูดผานเครื่องอานบัตรแถบแมเหล็กก็จะมีการสงสัญญาณ Interrupt ออกมายัง 
CPU ซึ่งผูใชก็เพียงแตเขียนโปรแกรมสําหรับบริการการ Interrupt ของ INT1 ไวก็สามารถใชงานไดแลว 

 
 
 
 
 
 
 

รูปแสดง ลักษณะของการจัดเรียงสัญญาณของขั้วตอ 
เครื่องอานบัตรแถบแมเหล็ก MCR-B02TTL 
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 ***หมายเหตุ*** เนื่องจากการเลือกใช Interrupt จากสัญญาณ INT1 ของ CPU นั้น ภายในบอรด รุน 
CP-AVR V4.0 สัญญาณ INT1 จะถูกออกแบบใหสามารถเลือกกําหนดใชงานรวมกับอุปกรณหลายๆตัว เชน 
การ Interrupt จากไอซีขยาย PORT I/O เบอร PCF8574/A และการ Interrupt จาก เครื่องอานบัตรแถบแมเหล็ก 
MCR-B02TTL ดังนั้นในกรณีที่ตองการเลือกใชวิธีการ Interrupt จาก INT1 นั้น จะตองทําการ OPEN JUMPER 
สําหรับเลือกการ Interrupt จากอุปกรณอื่นๆที่ไมเกี่ยวของออกเสียกอน ใหเหลือการเชื่อมตอสัญญาณ INT1 
จาก CPU กับอุปกรณเพียงตัวใดตัวหนึ่งเทานั้น เพื่อใหแนใจวาสัญญาณ Interrupt ที่เกิดขึ้นจะถูกสงมาออกมา
จากเครื่องอานบัตรแถบแมเหล็กเทานั้น ไมเชนนั้นแลวอาจเกิดความผิดพลาดขึ้นได 
 
การใชงาน OUTPUT RELAY 
 ภายในบอรด CP-AVR V4.0 นั้น จะออกแบบวงจรควบคุม  RELAY ไวใหผูใชงานสามารถนําไป
ประยุกตใชงานทั่วไปไดดวย จํานวน 1 ชุด โดยวงจร RELAY ดังกลาวสามารถใชงานได ทั้งหนาสัมผัสแบบปรกติ
เปด (Normal Open : NO) และแบบหนาสัมผัสปรกติปด (Normal Close : NC)  
 สําหรับสัญญาณ Output ในการควบคุมการทํางานของ RELAY นั้น จะแบงมาจาก PA7 ของ CPU ซึ่ง
เมื่อตองการใชงาน RELAY จะตองทําการ SHORT JUMPER PA7(RELAY) ไวดวยเพื่อเชื่อมตอสัญญาณ PA7 
มาทําการควบคุมการทํางานของ RELAY และตองแนใจวาไมไดตอสัญญาณ PA7 จากขั้วตออื่นๆออกไปใชงาน
กับอุปกรณใดๆนอกเหนือจาก RELAY เนื่องจากสัญญาณ PA7 นั้น นอกจากจะตอมาใชควบคุมการทํางานของ 
RELAY แลวยังตอไปยังขั้วตอ 34PIN และขั้วตอ PA(ADC) ดวย โดยการทํางานของ RELAY จะถูกควบคุมการ
ทํางานจากขาสัญญาณ PA7 ผูใชตองกําหนดคุณสมบัติของสัญญาณ PA7 ใหทําหนาที่เปน OUTPUT ซึ่งเมื่อขา
สัญญาณ  PA7 มีสภาวะเปน OUTPUT และใหสถานะเปน “1” จะทําให RELAY ทํางาน แตถาสถานะของ
สัญญาณ PA7 มีคาเปน “0” จะทําให RELAY หยุดทํางาน 

 

ปรกติเปด

จุดรวม

ปรกติปด

 
รูปแสดง ลักษณะขั้วตอสัญญาณจากหนาสัมผัสของ RELAY 

 
 

 ***หมายเหตุ*** เนื่องจากสัญญาณ PA7 ที่นํามาใชควบคุมการทํางานของ RELAY จะเปนสัญญาณ
เสนเดียวกับ PA7 ที่ตอไวยังขั้ว 34PIN และขั้วตอ 10PIN แบบ IDE ของพอรต PA(ADC) ดังนั้น เมื่อตองการใช
งาน RELAY โดยการควบคุมจาก PA7 แลว ตองแนใจวาไมไดตอใชงานสัญญาณ PA7 ในจุดอื่นๆดวย แตถา
หากมีความจําเปนตองใชงาน PA7 พรอมกับการใชงาน RELAY ดวยในเวลาเดียวกัน ก็อาจดัดแปลงวงจรไดโดย
การ OPEN JUMPER PA7(RELAY) ออก แลวใชวิธีการเชื่อมสายสัญญาณเสนอื่นๆจาก PORT I/Oของ CPU ที่
ไมไดใชงานมาเขากับวงจรควบคุม RELAY แทนก็ไดเชนเดียวกัน โดยใหเชื่อมตอสายสัญญาณที่ตองการไปยัง 
Jumper PA7(RELAY) ดานที่ตอกับตัวตานทานคา  1KOhm แตการดัดแปลงวิธีนี้ควรถอดตัว  JUMPER 
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PA7(RELAY) ออกจากบอรดเสียกอน เพื่อจะไดไมหลงลืมทําการ SHORT JUMPER นี้ซ้ําอีกในภายหลัง เนื่อง
จากจะเปนการ SHORT สัญญาณ PA7 เขากับสัญญาณเสนใหมที่บัดกรีมายังวงจร RELAY นี้อีก 
 
การใชงานลําโพงขนาดเล็ก หรือ BUZZER 
 ภายในบอรด CP-AVR V4.0 จะมีวงจรกําเนิดเสียงรวมอยูดวย 1 จุด ซึ่งในตําแหนงนี้สามารถเลือกใส
อุปกรณกําเนิดเสียงแบบลําโพงขนาดเล็ก หรือ จะเลือกใส BUZZER แทนก็ไดเชนเดียวกัน โดยในกรณีที่เลือกใช
ลําโพงจะมีขอดีคือ สามารถสรางความถี่เสียงไดหลากหลายความถี่ตามตองการแตการเขียนโปรแกรมจะยุงยาก
กวา BUZZER เนื่องจากตองสรางเปนสัญญาณความถี่จึงจะสามารถทําใหลําโพงกําเนิดเสียงใหได สวนในกรณี
ที่เลือกใช BUZZER นั้น จะมีขอดีคือ เขียนโปรแกรมควบคุมการกําเนิดเสียงไดงายกวาลําโพง เนื่องจากใชวิธีการ 
ON หรือ OFF เทานั้น โดยการ ON บิตควบคุม BUZZER ใหมีสภาวะเปน “1” เทานั้น BUZZER ก็จะกําเนิดเสียง
ใหแลว แตความถี่เสียงของ BUZZER จะไมสามรถเลือกได เหมือนกับลําโพง 
 สําหรับสัญญาณ Output ในการควบคุมการทํางานของ ลําโพง หรือ BUZZER นั้น จะแบงมาจาก PB7 
ของ CPU ซึ่งเมื่อตองการใชงาน ลําโพง หรือ BUZZER จะตองทําการเลือก JUMPER 4x4/SPK มารอไวยัง
ตําแหนง SPK ดวย เพื่อใหสามารถนําสัญญาณ PB7 มาทําการควบคุมการทํางานของลําโพง หรือ BUZZER ได 
โดยผูใชตองทําการกําหนดคุณสมบัติของสัญญาณ PB7 ใหทําหนาที่เปน OUTPUT ไวดวย ซึ่งเมื่อขาสัญญาณ 
PB7 มีสภาวะเปน OUTPUT และใหสถานะเปน “1” จะทําให ลําโพง หรือ BUZZER ทํางาน แตถาสถานะของ
สัญญาณ PB7 มีคาเปน “0” จะทําให ลําโพง หรือ BUZZER หยุดทํางาน 
 

***หมายเหตุ*** เนื่องจากสัญญาณ PB7 ที่นํามาใชควบคุมการทํางานของ ลําโพง หรือ BUZZER นั้น
จะเปนสัญญาณเสนเดียวกับ PB7 ที่ตอไวยังขั้ว 34PIN และขั้วตอ 10PIN แบบ IDE ของพอรต PB(KBI) ดวย ดัง
นั้นเมื่อตองการใชงานลําโพง หรือ BUZZER โดยการควบคุมจาก PB7 แลว ตองแนใจวาไมไดตอใชงาน
สัญญาณ PB7 ในจุดอื่นๆทั้งสอง ดังกลาวดวย แตถาหากมีความจําเปนตองใชงาน PB7 พรอมกับการใชงาน 
ลําโพง หรือ BUZZER ดวยในเวลาเดียวกัน ก็อาจดัดแปลงวงจรได โดยการใชวิธีการบัดกรีเชื่อมสายสัญญาณ
เสนอื่นๆจาก PORT I/Oของ CPU ที่ไมไดใชงานมาเขากับวงจรควบคุมลําโพงหรือ BUZZER แทนก็ไดเชนเดียว
กัน โดยใหเชื่อมตอสายสัญญาณที่ตองการไปยัง Jumper 4x4/SPK ดาน SPK แตการดัดแปลงวิธีนี้ควรถอดตัว 
JUMPER 4x4/SPK ออกจากบอรดเสียกอนแลวทําการเชื่อมตอขาสัญญาณ Jumper 4x4/SPK ดาน ตําแหนง 
4x4 ไวดวยกันเลย เพื่อจะไดไมหลงลืมทําการเลือก JUMPER กลับมายังดาน SPK นี้อีกในภายหลัง เนื่องจากจะ
เปนการ SHORT สัญญาณ PB7 เขากับสัญญาณเสนใหมที่บัดกรีมายังวงจรควบคุมลําโพงหรือ BUZZER นี้อีก 
 
การใชงานจอแสดงผลแบบ LCD (Dot-Matrix Character LCD) 
 บอรด CP-AVR V4.0 สามารถใชเชื่อมตอกับจอแสดงผล LCD แบบ Dot-Matrix โดยเชื่อมตอผานทาง 
Connector ขนาด 14 PIN และใชตัวตานทานปรับคาไดแบบเกือกมาขนาด 10K สําหรับปรับระดับความสวาง
ของหนาจอ LCD โดยวงจรในการเชื่อมตอ LCD ของบอรดนี้จะออกแบบวงจรใหใชวิธีการควบคุมการทํางาน
แบบ "DATA 4-BIT"  
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รูปแสดง ขาสัญญาณของขั้วตอ CLCD 
 

สําหรับวิธีการเชื่อมตอสัญญาณจากขั้วตอ CLCD ของบอรดไปเขากับตัว LCD นั้น เพื่อความสะดวก
ขอแนะนําใหใชสายแพร ขนาด 14 เสน เปนตัวเชื่อมตอสัญญาณระหวางบอรดและตัว LCD จะสะดวกมากที่สุด  
ซึ่งในปจจุบันพบวา ลักษณะขั้วสัญญาณที่อยูทางดานของจอแสดงผล LCD เองนั้น ที่พบเห็นไดทั่วๆไป จะมีอยู 
ดวยกัน 2 แบบ คือ 

- แบบที่เปนขั้วตอแบบแถวเดี่ยว ขนาด 14PIN (HEADER 14X1) โดยการตอสายของ LCD แบบนี้ 
จะใชสายแพรขนาด 14 เสน แบบเขาหัว CONNECTOR ไวดานเดียว สําหรับเสียบกับขั้วตอ 
CLCD ภายในบอรด CP-AVR V4.0 สวนปลายสายอีกดานหนึ่งของสายแพรทั้ง 14 เสน จะตองนํา
ไปบัดกรีเขากับขั้วตอของตัว LCD ใหครบทั้ง 14 เสน โดยในการบัดกรีจะตองสลับปลายสายเปน
คูๆเรียงลําดับกันไป คือ ขา 2 สลับกับ 1,ขา4 สลับกับ 3…ขา14 สลับกับ 13 ตามลําดับ กลาวคือ 
สายเสนที่1 ตอกับ PIN2 ของ LCD สวนสายเสนที่2 จะตองตอกับ PIN1 ของ LCD และในทํานอง
เดียวกันสายเสนที่3 ก็จะตองตอกับ PIN4 ของ LCD อยางนี้เรื่อยไปจนครบทั้ง 14 เสน 

- แบบที่เปนขั้วตอแบบแถวคู 14PIN (HEADER ขนาด 7X2) โดยการตอสายของ LCD แบบนี้ จะใช
สายแพรขนาด 14 เสน แบบเขาหัว CONNECTOR ไวทั้งสองดาน โดยในการเชื่อมตอนั้น ใหตอ
สายแตละดานเขากับขั้วตอ โดยใหตําแหนงของ PIN1 ของขั้วตอแตละดานอยูในตําแหนงที่ตรงกัน
ก็สามารถใชงานไดแลว 

 
 ***หมายเหตุ*** ใน CLCD บางรุนนั้น อาจมีขั้วตอสัญญาณเพิ่มเปน ขนาด 16 PIN ซึ่งในกรณีนี้ ก็จะ
ยังคงใชวิธีการเชื่อมตอแบบเดิม คือจะใชสัญญาณในการเชื่อมตอระหวาง CLCD กับบอรด เพียงแค 14 PIN เทา
นั้น สวนสัญญาณขา 15 และ 16 ที่เพิ่มเขามานั้นจะเปนขาไฟเลี้ยงของวงจร LED Back-Light (A และ K) ซึ่งถา 
LCD ที่ซื้อมาใชงานมี LED Back-Light รวมอยูดวย ขอแนะนําใหแยกตอไฟเลี้ยง LED Back-light เขากับแหลง
จายไฟ +5V โดยตรงตางหากก็ได หรือถาตองการให LED Back-Light ทํางานตลอดเวลาก็อาจทําการตอขา
สัญญาณ (A) หรือขา 15 เขากับ ขา 2 ของ LCD สวนขา (K) ก็ใหตอเขากับขา 1 ของ LCD ก็ไดเชนกัน 
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รูปแสดง วิธีการตอสาย LCD แบบใชขั้วแถวเดี่ยว 
 
การเชื่อมตอกับอุปกรณ I2C BUS 

สําหรับอุปกรณแบบ I2C Bus ที่ใชในบอรด CP-AVR V4.0 นั้น จะออกแบบใหสามารถติดตั้งใชงาน
อุปกรณ I2C ไดพรอมกันในบอรดทั้งหมดดวยกัน 3 ตัว คือ  

- I2C RTC  เบอร PCF8583 ของ PHILIPS  
- EEPROM ในตระกูล 24XX ซึ่งสามารถเลือกใชไดหลายเบอรหลายผูผลิต ขึ้นอยูกับขนาดความจุ

ของหนวยความจําที่ตองการจะใช  ซึ่งในบอรด CP-AVR V4.0 นั้น สามารถติดตั้งใชงานหนวย
ความจํา EEPROM แบบ I2C นี้ไดตั้งแต เบอร 24XX32,24XX64,24XX128,24XX256 หรือ 
24XX512 เปนตน 

- I2C I/O เบอร PCF8574 หรือ PCF8574A ของ Phillips 
โดยอุปกรณ I2C ทั้ง 3 ตัวนี้จะตอรวมกันอยูภายในบัสเดียวกัน และใชสัญญาณ PC1 เปนขาสัญญาณ 

SDA และใชสัญญาณ PC0 เปนสัญญาณ SCL ในการควบคุมบัส ซึ่ง CPU จะทําหนาที่เปนตัวแมในการควบคุม
บัส นอกจากนี้แลวยังสามารถขยายอุปกรณจําพวก I2C นี้ไดอีก แตตองเปนอุปกรณที่มีรหัสควบคุม Control 
Word ไมซ้ํากันกับอุปกรณที่มีอยูแลวภายในบอรดดวย โดยอาจเชื่อมตอผานทางขั้วตอ “I2C EXPANSION” ที่
บอรดจัดเตรียมไวใหแลวก็ได 

สําหรับในการใชงานอุปกรณ I2C นั้น เนื่องจาก CPU เบอร AT90S8535 ไมมีสวนของฮารดแวรที่ทํา
หนาที่ติดตอส่ือสารแบบ I2C บรรจุไวในตัว CPU ดวย ดังนั้นจึงตองใชวิธีการนํา I/O Port ของ CPU มาใชติดตอ
กับอุปกรณแบบ I2C แทน โดยกําหนดให 

- SDA ตอกับขา PC1 ทําหนาที่เปนสัญญาณขอมูลแบบ 2 ทิศทาง ใชสําหรับรับสงขอมูลจาก CPU 
กับอุปกรณ I2C โดยเมื่อ CPU ตองการเขียนขอมูลไปยังอุปกรณ ผูใชจะตองกําหนดใหสัญญาณนี้
ทําหนาที่เปน Output แตเมื่อ CPU ตองการอานหรือรับขอมูลจากอุปกรณ ผูใชก็ตองกําหนดให

จอแสดงผล Character LCD
แบบ Dot Matrix

ขา14 ขา1
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สัญญาณนี้ทําหนาที่เปน Input แทนและตองกําหนดการ Pull-Up ใหกับสัญญาณที่ทําหนาที่เปน 
SDA นี้ดวยเสมอ  

- SCL ตอกับขา PC0 ทําหนาที่เปนสัญญาณนาฬิกา Clock สําหรับใชติดตอส่ือสารกับอุปกรณ I2C 
สัญญาณ SCL นี้จะเปนสัญญาณ Output จาก CPU เพื่อใชควบคุมการรับสงขอมูลระหวาง CPU 
กับอุปกรณ  

สําหรับการใชงานฟงกชั่น I2C ใน CPU เบอร ATmega163 นั้นเราสามารถเลือกวิธีการติดตอส่ือสารขอ
มูลแบบการกําหนดใหพอรตทํางานเปน I/O ดังที่ไดอธิบายมาแลวในขางตนหรือจะเลือกใชฟงกชั่น 2-wire Serial 
Interface ที่มีอยูในตัวไอซีเบอรนี้ก็ได ซึ่งฟงกชั่นนี้จะเปนฟงกชั่นที่ใชสําหรับส่ือสารขอมูลในมาตรฐาน I2C โดย
เฉพาะ ทําใหเราสามารถเขียนโปรแกรมไดงายและมีประสิทธิภาพมากขึ้น  
 
การใชงาน Interrupt ของอุปกรณ I2C 

สําหรับในสวนของอุปกรณ I2C ที่อยูภายในบอรดนั้น จะมีอยู 2 อุปกรณดวยกัน ที่สามารถสราง
สัญญาณ Interrupt ใหกับ CPU ได คือ RTC เบอร PCF8583 และ I/O Port เบอร PCF8574/A ซึ่งในการเลือก 
Interrupt ใหกับอุปกรณทั้งสองนั้น ถาผูใชเลือก Short Jumper I/O INT1 จะเปนการตอขา INT(ขา 13) ของ 
PCF8574/A เขากับขา INT1 ของ CPU และในขณะเดียวกันสัญญาณ INT1 นี้ก็จะถูกตอผานไปยังขั้ว I2C BUS 
EXPAND ดวย และถาผูใชเลือก Short Jumper RTC INT0 จะเปนการตอขา INT(ขา 7) ของ PCF8583 เขากับ
ขา INT0 ของ CPU อยางไรก็ตามทั้งสัญญาณ INT0 และ INT1 ของ CPU นี้จะถูกตอโดยตรงเขากับขั้ว 34 Pin 
 
 ***หมายเหตุ*** ไมควรทําการ Short Jumper ของ INT0 หรือ INT1 เขากับอุปกรณมากกวา 1 
อุปกรณ เนื่องจากจะเปนการยุงยากในการเขียนโปรแกรมเพื่อตรวจสอบแหลงที่มาของการ Interrupt วามาจาก
อุปกรณตัวใด 

 
แอดเดรสของอุปกรณ I2C  
 เนื่องจากคุณสมบัติของ BUS แบบ I2C นั้น สามารถเชื่อมตออุปกรณตางๆที่ใชวิธีการสื่อสารแบบ  I2C 
ไดมากมากหลายตัวภายในบัสเดียวกันได เพียงแตมีขอแมวา อุปกรณที่จะนํามาตอรวมกันภายในบัสเดียวกันนั้น 
จะตองมีรหัสตําแหนงในการติดตอส่ือสาร (Control Byte) ที่ไมซ้ํากัน ซึ่งอุปกรณบางตัวนั้น ผูผลิตไดมีการออก
แบบใหสามารถกําหนดคารหัสตําแหนง Control Byte ไดมากกวา 1 คาเพื่อใหสามารถเชื่อมตออุปกรณประเภท
เดียวกันรวมกันภายในบัสเดียวกันไดมากกวา 1 ตัว โดยใชวิธีการกําหนดคาโลจิกใหกับขาสัญญาณสําหรับใช
ระบุตําแหนง (Address) ของอุปกรณเบอรนั้นๆไดเอง เชน I/O Port เบอร PCF8574 นั้น สามารถตอรวมกันภาย
ในบัสเดียวกันไดมากถึง 8 ตัว และยังสามารถเชื่อมตออุปกรณ I/O Port ที่มีคุณสมบัติเหมือนกันแตมีรหัส
ตําแหนงที่แตกตางกันคือ PCF8574A เพิ่มเติมไดอีก 8 ตัว ซึ่งจะเห็นไดวาอุปกรณ I/O Port นั้นสามารถทําการ
เพิ่มเติมเขาไปใหระบบบัสเดียวกันไดมากถึง 16 ตัว และในทํานองเดียวกัน หนวยความจํา EEPROM เบอร 
24LC256 ก็สามารถตอรวมกันภายในบัสเดียวกันไดมากถึง 8 ตัว จากตัวอยางขางตนจะเห็นไดวาภายในบัส
เดียวกันของ I2C นั้น อุปกรณเพียง 2 ประเภท คือ I/O และ EEPROM สามารถตอรวมกันภายในบัสเดียวกันได
มากถึง 24 ตัว คือ I/O PCF8574 8 ตัว ,PCF8574A 8ตัว และ 24LC256 อีก 8 ตัว และยังสามารถนําอุปกรณ 
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I2C อื่นๆที่มีรหัสตําแหนงของ Control Byte ไมซ้ํากันมาตอเพิ่มเติมไดอีก แตอยางไรก็ตามถึงแมวาอุปกรณแบบ 
I2C นี้ยอมใหมีการเชื่อมตอรวมกันภายในบัสเดียวกันไดหลายตัวภายในระบบบัสเดียวกันก็ตาม แตในทางปฏิบัติ
แลวอาจเกิดขอจํากัดในเรื่องของโหลด (FAN-IN/FAN-OUT) เนื่องจากคุณสมบัติของ Port I/O ของ CPU เอง ก็มี
ขอจํากับในการขับกระแสใหกับโหลดไดประมาณ 20mA เทานั้น ซึ่งคงไมสามารถตออุปกรณรวมกันในบัสไดโดย
ไมจํากัดจํานวนเหมือนในทฤษฎีบอกไว ซึ่งในความเปนจริงอาจตองพิจารณาตามความเหมาะสมและความจํา
เปนในการใชงานจริงๆดวยวาในระบบบัสหนึ่งๆของ I2C นั้นควรตออุปกรณในบัสจํานวนเทาใด 

 

 หนาที่และเบอร รหัสตําแหนงมาตรฐาน รหัสตําแหนงของบอรด CP-AVR V4.0  
 ของอุปกรณ I2C ในการอาน/เขียน รหัสตําแหนงในการอาน รหัสตําแหนงในการเขียน  
 RTC : PCF8583 [1][0][1][0][0][0][X][?] [1][0][1][0][0][0][1][1] [1][0][1][0][0][0][1][0]  
 E2PROM:24XX [1][0][1][0][X][X][X][?] [1][0][1][0][1][0][0][1] [1][0][1][0][1][0][0][0]  
 I/O : PCF8574 [0][1][0][0][X][X][X][?] [0][1][0][0][0][0][0][1] [0][1][0][0][0][0][0][0]  
 I/O : PCF8574A [0][1][1][1][X][X][X][?] [0][1][1][1][0][0][0][1] [0][1][1][1][0][0][0][0]  

 

ตารางแสดง รหัสตําแหนงของอุปกรณ I2C ภายในบอรด CP-AVR V4.0 
 

***หมายเหตุ*** 1.  คา X หมายถึงคาโลจิกของขาสัญญาณ Address ของอุปกรณ ที่กําหนดในวงจร 
  2. คา ? หมายถึงบิตสําหรับกําหนดวาตองการเขียน หรือ อาน ขอมูลกับอุปกรณ 
  3. เนื่องจาก RTC เบอร PCF8583 และ EEPROM เบอรในกลุม 24XX นั้นมีรหัสตําแหนง 4
บิตแรก ซ้ํากัน หรือ อยูในกลุมเดียวกัน ซี่งในบอรด CP-AVR V4.0 นั้นออกแบบให RTC เบอร PCF8583 มีรหัส
ตําแหนงของ Control Byte คงที่เปน 1010001X ไว สวน EEPROM ก็กําหนดรหัสตําแหนง Control Byte ไวที่ 
1010100X ดังนั้นถาตองการเพิ่มเติมอุปกรณใดๆเขาไปอีกตองกําหนดใหคา Control Byte ของอุปกรณที่จะตอ
เพิ่มเขาไปไมซ้ํากับคา Control Byte ทั้งสองดังกลาวนี้ดวย 
 
การใชงาน I2C RTC เบอร PCF8583 

สําหรับวงจรฐานเวลา RTC นั้น ในบอรด CP-AVR V4.0 นั้น จะเลือกใช Chips Support ของ PHILIPS 
เบอร PCF8583 ซึ่งเปนชิพฐานเวลาแบบ I2C-Bus และมีฐานเวลาใหใชงานอยางครบถวน ตั้งแต วินาที/นาที/ชั่ว
โมง/วันที่/เดือน/วันในสัปดาห และปคศ. นอกจากนี้ยังมีความออนตัวในการใชงานคอนขางดีเกี่ยวกับระบบเวลา 
เชน คาของชั่วโมงสามารถกําหนดไดจากโปรแกรมวาจะใหเปนระบบ 12 ชั่วโมง หรือ 24 ชั่วโมง และในสวนของ
วันที่และวันในสัปดาหก็สามารถปรับเปล่ียนไดเองวา เดือนใดมี 28/29/30 หรือ 31 วันอยางอัตโนมัติ ซึ่งนอกจาก
จะใชงานเปนฐานเวลา RTC แลว PCF8583 นี้ยังมีฟงกชั่นพิเศษในการตั้งเวลาสําหรับเปดปดการทํางานของ
อุปกรณตางๆ (ALARM FUNCTION) ไดอีกดวย นอกจากนี้แลวในตัวของ RTC เองยังมีหนวยความจํา RAM 
ขนาด 8บิต จํานวน 240ไบท สําหรับใหผูใชนําไปใชงานเก็บขอมูลไดอยางอิสระ เชน อาจนําไปใชในการเก็บคา
การตั้ง เวลา เพื่อใช ตั้งเวลาเปด-ปด อุปกรณไฟฟา เปนตน 
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       รูปแสดง โครงสรางภายในของ RTC เบอร PCF8583 
 

 จะเห็นไดวา PCF8583 ประกอบขึ้นจากวงจรหลายๆสวน เชน วงจร Power-on Reset วงจรเชื่อมตอ
แบบ I2C วงจรถอดรหัสตําแหนงแอดเดรส วงจรหารความถี่ และวงจรกําเนิดความถี่ขนาด 32.768KHz โดยตอง
ตอคริสตัลจากภายนอกใหกับขา OSCI และ OSCO ดวย สําหรับหนวยความจํานั้น PCF8583 จะมีโครงสราง
ของหนวยความจําขนาด 8บิต จํานวน 256 ไบท โดยจัดสรรสําหรับแบงออกเปนรีจิสเตอรของสวนที่เปนฐานเวลา
จํานวน 16ไบท(00H-0FH) และใชงานเปน หนวยความจํา RAM ทั่วไปไดอีก 240ไบท(10H-FFH) ซึ่งในการ
ประยุกตใชงานนั้น ตามปรกติแลวจะสามารถใชงานในหนาที่ของ RTC(Clock Mode) หรือใชงานเปนตัวนับ 
Counter (Event Counter) สําหรับนับความถี่จากขาสัญญาณ OSCI ก็ได แตสําหรับวงจรของ PCF8583 ภาย
ในบอรด CP-AVR V4.0 นั้นจะออกแบบใหใชงาน PCF8583 ในโหมด RTC หรือ Clock Mode เทานั้น 
 
การติดตอส่ือสารกับ RTC เบอร PCF8583 
 ในการเขียนโปรแกรมติดตอกับ RTC นั้น จะใชวิธีการเชื่อมตอแบบมาตรฐาน I2C Bus โดยใน RTC 
เบอร PCF8583 นี้จะมีตําแหนงแอดเดรสในการติดตอภายในบัส หรือ Control Byte เปน “1010001X” ดังนั้นใน
การติดตอกับ RTC ไมวาจะเปนการเขียนขอมูลหรืออานขอมูลจากตัว RTC ก็ตาม หลังจากสรางสภาวะเริ่มตน 
(Start Condition) แลวจะตองสงคา Control Byte ของตัว RTC ในบัส ดวยคา “1010001X”  เพื่อบอกให RTC 
รับรูวา CPU ตองการจะอานหรือเขียนขอมูลใหกับ RTC จากนั้นจึงสงรหัส ไบทแอดเดรส เพื่อระบุตําแหนงแอด
เดรสเริ่มตนภายในตัว RTC ที่ตองการจะอานหรือเขียนขอมูลใหกับ RTC เปนลําดับตอไป โดยถาเปนตําแหนง
แอดเดรสของฐานเวลาภายในตัว RTC จะมีคาตําแหนงแอดเดรสอยูระหวาง 00H-0FH แต ถาเปนตําแหนงแอด
เดรสของ RAM ภายในตัว RTC จะมีคาอยูระหวาง 10H-FFH ตามลําดับ โดยรหัส Control Byte ของ RTC นั้นมี
ลักษณะโครงสรางดังนี้ 
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รูปแสดง โครงสรางของ Control Byte ของ PCF8583 
 
 ซึ่งจะเห็นวาตามสภาวะปรกติแลว Control Byte ของ PCF8583 นั้น สามารถเลือกได 2 คา โดยการ
กําหนดโลจิกใหกับขาสัญญาณ A0 ของ PCF8583 เอง ดังนั้นในระบบบัสเดียวกัน จึงสามารถทําการติดตั้ง RTC 
เบอร PCF8583 นี้ได 2 ตัว โดยตองกําหนดใหขาสัญญาณ A0 ของแตละตัวมีสภาวะเปน “0” และ “1” ซึ่ง ตัวที่
ขาสัญญาณ A0 มีสภาวะเปน “0” ก็จะมีรหัส Control Byte เปน “1010000X” สวนตัวที่ขาสัญญาณ A0 ไดรับ
สภาวะลอจิกเปน “1” ก็จะมีรหัส Control Byte เปน “1010001X” แทน 
 แตสําหรับบอรด CP-AVR V4.0 นั้น จะกําหนดใหขาสัญญาณ A0 ของ PCF8583 มีสภาวะทางโลจิก
เปน “1” คงที่ไวเลย ดังนั้น RTC เบอร PCF8583 ในบอรด CP-AVR V4.0 นั้นจึงมีรหัส Control Byte คงที่เปน 
“1010001X” เสมอ 
 
 ***หมายเหตุ*** คา X หรือ บิต0(R/W) ใน Control Byte เปนบิตสําหรับกําหนดคุณสมบัติในการอาน
หรือเขียนขอมูลกับอุปกรณ I2C โดยถาหากวาบิต0 มีคาเปน “0” จะหมายถึง CPU ตองการเขียนคาไปยังอุปกรณ 
แตถาคาในบิต0 มีคาเปน “1” จะหมายถึง CPU ตองการอานคาจากอุปกรณ เชนรหัส Control Byte ของ RTC 
เบอร  PCF8583 มี ค า  “1010001X” ถ าต อ งการเขี ยนค า ไปยั ง  RTC จะต อ งส งรหั ส  Control Byte เป น 
“10100010” แตถาตองการอานคาจาก RTC ก็จะตองสงรหัส Control Byte ดวยคา “10100011” แทน เปนตน 
 
การใชงานหนวยความจํา EEPROM (24XX) 
 หนวยความจํา Serial EEPROM ที่ใชในบอรดจะใชการเชื่อมตอแบบ I2C-Bus ในตระกูล 24XX ซึ่ง
หนวยความจําแบบนี้มีคุณสมบัติที่นาสนใจหลายประการคือ มีตัวถังขนาดเล็ก ใชสัญญาณในการเชื่อมตอนอย
เสน และสามารถเก็บรักษาขอมูลไวไดนานกวา 200 ป นอกจากนี้ยังสามารถลบและเขียนซ้ําไดถึง 1 ลานครั้ง 
(อางอิงจาก Microchip) จึงสามารถนําไปประยุกตใชงาน ในดานที่เกี่ยวของกับการเก็บรักษาขอมูลสําหรับงาน
ตางๆไดดี 
 โดยผูใชเองสามารถเลือกติดตั้งหนวยความจําเพื่อใชงาน กับบอรดไดมากมายหลายเบอร ขึ้นอยูกับจุด
ประสงคและขนาดของหนวยความจําที่ตองการ โดยใหเลือกใช EEPROMในตระกูล 24XX (I2C Bus) ในกลุมที่
สามารถกําหนดรหัส Control Byte ของหนวยความจําจากฮารดแวร (ขาสัญญาณ A2,A1 และ A0) ได เชน 
เบอร 24XX32,64,128 และ 24XX256 ของ Microchip เปนตน 

สําหรับหนวยความจําเบอร 24XX32,24XX64,24XX128 และ 24XX256 ของ Microchip นั้น จะเห็นได
วารหัส Control Byte ในตําแหนง 4บิตบน (บิต7,6,5 และ 4) จะมีคาเปน “1010” สวน บิต3 บิต2 และ บิต1 นั้น
จะขึ้นอยูกับสภาวะทางลอจิกของขาสัญญาณ A2,A1 และ A0 ในวงจร ซึ่งจากคุณสมบัติดังกลาวจะทําให

1 0 1 0 0 0 A0 R/W
บิต7 บิต6 บิต5 บิต4 บิต3 บิต2 บิต1 บิต0
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สามารถทําการตอหนวยความจําดังกลาวไดมากถึง 8 ตัวภายในระบบบัสเดียวกัน โดยกําหนดสภาวะของขา 
สัญญาณลอจิกแอดเดรสที่แตกตางกันออกไป โดยสามารถสรุปใหเห็นไดดังตารางตอไปนี้ 

 

เบอร(ความจุ) Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 
24XX32 (4Kx8) 1 0 1 0 A2 A1 A0 R/W 
24XX64 (8Kx8) 1 0 1 0 A2 A1 A0 R/W 
24XX128 (16Kx8) 1 0 1 0 A2 A1 A0 R/W 
24XX256 (32Kx8) 1 0 1 0 A2 A1 A0 R/W 

 

ตารางแสดง รหัส Control Byte ของหนวยความจําแบบ I2C Bus ของ Microchip 
 

 จากตารางจะเห็นไดวา หนวยความจํา EEPROM แบบ  I2C-BUS นั้น  24XX32/64/128/256 ของ 
Microchip นั้นจะมีรหัส Control Code ที่เหมือนกันทุกเบอร แตจะมีความแตกตางกันที่ขนาดของหนวยความจํา 
ดังนั้นเมื่อทําการติดตั้งใชงานหนวยความจําเบอรเหลานี้กับบอรด CP-AVR V4.0 แลวจะมีรหัส Control Byte 
เปน “1010100X” คงที่ตลอด แตถามีการตอหนวยความจําเหลานี้เพิ่มเติมจากภายนอกบอรดแลวรหัส Control 
Byte ก็จะขึ้นอยูกับการกําหนดสภาวะทางลอจิกใหกับขาสัญญาณ A2,A1 และ A0 ของหนวยความจําที่ตอไว 
  
การใชงาน I/O Port แบบ I2C (PCF8574/A) 

หากในการใชงานมีความจําเปนตองใชงานพอรต I/O จํานวนมาก และจํานวนพอรต I/O ของ CPU ที่มี
อยูไมเพียงพอตอการใชงานแลว ผูใชสามารถทําการเพิ่มเติมพอรต I/O ไดอีก โดยในบอรด CP-AVR V4.0 นั้นจะ
ออกแบบใหผูใชสามารถทําการเพิ่มเติม พอรต I/O แบบ I2C ซึ่งมีขนาด I/O จํานวน 8 บิต I/O โดยใชไอซี สําหรับ
ทําหนาที่เปนพอรต I/O ของ Phillips เบอร PCF8574 หรือ PCF8574A โดย PCF8574/A มีโครงสรางดังรูป 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปแสดง Block Diagram ของ PCF8574/A 
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โดยที่ พอรต I/O เบอร PCF8574/A นั้น ตามปรกติแลวจะสามารถใชงานเปน Input หรือ Output ก็ได
ตามตองการ แตจําเปนตองเลือกกําหนดหนาที่เพียงหนาที่เดียวเทานั้น ไมสามารถใชงานเปนทั้ง Input และ 
Output ในเวลาเดียวกันได โดยลักษณะโครงสรางภายในของขาสัญญาณ I/O ของ PCF8574 เปนดังนี้ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
รูปแสดง ลักษณะโครงสรางของขาสัญญาณ I/O แตละขาของ PCF8574/A 
 
นอกจากนี้แลวผูใชงานยังสามารถทําการขยาย จํานวนพอรต I/O ของ PCF8574/A นี้ไดอีกมากถึง 15 

ตัว (120 บิต I/O) ทางขั้วตอ “I2C EXPAND” ของบอรด เนื่องจาก PCF8574 หรือ PCF8574A นั้น สามารถตอ
รวมกันภายในระบบบัสเดียวกันไดมากถึงอยางละ 8 ตัว กลาวคือ ในระบบบัสของ I2C นั้น จะสามารถตอใชงาน 
PCF8574 ไดมากถึง 8 ตัว และยังสามารถตอพอรต I/O เบอร PCF8574A ไดอีก 8 ตัว รวมเปน 16 ตัวภายในบัส
เดียวกัน โดยการกําหนดตําแหนงแอดเดรสของอุปกรณแตละตัวใหมีความแตกตางกัน ซึ่งตามปรกติแลว 
PCF8574 หรือ PCF8574A นั้น จะมีขาสัญญาณแอดเดรสจํานวน 3 เสน คือ  A0,A1 และ A2 โดยการกําหนด
สภาวะทางโลจิกใหกับขาสัญญาณแอดเดรสทั้ง 3 ใหมีคาไมซ้ํากัน โดย PCF8574 และ PCF8574A นั้น จะมีคุณ
สมบัติและวิธีการใชงานที่เหมือนกันทุกประการ แตกตางกันเพียงรหัส Control Byte เทานั้น โดยโครงสรางของ
รหัส Control Byte ของ PCF8574 และ PCF8574A สามารถแสดงใหเห็นไดดังนี้ 
 
 
 
 

รูปแสดง รหัส Control Byte ของ PCF8574 
 
 

0 1 0 0 A2 A1 A0 R/W
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รูปแสดง รหัส Control Byte ของ PCF8574A 

 
 สําหรับรหัส  Control Byte ของพอรต  I/O เบอร PCF8574 หรือ  PCF8574A ของบอรดนั้น  จะถูก
กําหนดไวตายตัว โดยขาสัญญาณแอดเดรส A0,A1 และ A2 จะถูกกําหนดสภาวะโลจิกเปน “0” ไวทั้งหมด ซึ่งใน
กรณีที่ผูใชทําการติดตั้งพอรต I/O เบอร PCF8574 จะมีรหัส Control Byte เปน “0100000X” แตสําหรับกรณีที่ผู
ใชทําการติดตั้งพอรต I/O เบอร PCF8574A จะมีรหัส Control Byte เปน “0111000X” แทน 

 
การใชงานพอรตสื่อสารอนุกรม SPI/RS232/RS422/RS485 
 พอรตที่ใชในการสื่อสารขอมูลแบบอนุกรมใน CPU เบอร 90S8535 จะมีอยู 2 พอรตดวยกันนั่นคือ SPI 
Port กับ Serial Port (RS232) สวน ATmega163 นั้น จะมีพอรตที่ใชในการสื่อสารขอมูลอนุกรมอยู 3 พอรตดวย
กันไดแกพอรต SPI  พอรตอนุกรม(RS232) และพอรต 2-wire Serial Interface ซึ่งพอรตนี้จะตอออกมาใชงาน
ภายนอกผานทางขั้ว I2C EXPAND และ ขั้วตอ I/O 34 Pin สําหรับบอรด CP-AVR V4.0 เราไดตอวงจร RS422 
และ RS485 เพิ่มเติม โดยใชไอซีเบอร 75176 ชวยปรับระดับของสัญญาณ ตอไปนี้เราจะกลาวถึงพอรตส่ือสาร
อนุกรมแบบตางๆ ที่อยูบนบอรดทั้ง 3 รุน 
 
การสื่อสารอนุกรม SPI 
 สําหรับพอรต SPI (Serial Peripheral Interface Port) นั้นปรกติเราจะใชในการดาวนโหลดโปรแกรม 
แตเราสามารถนํามันมาใชในการรับสงขอมูลแบบอนุกรมไดเชนเดียวกันกับพอรตอนุกรมอื่นๆ โดยในการใชงาน
นั้นเราจะตองมี CPU ที่ทําหนาที่เปนตัวมาสเตอรและ CPU ที่ทําหนาที่เปนตัวสเลฟ นั่นแสดงวาเราจะตองมี 
CPU อยางนอย 2 ตัวขึ้นไป และเราสามารถกําหนดให CPU ตัวที่จะมาตอกับพอรตนี้เปนตัวมาสเตอรหรือสเลฟ
ก็ไดโดยการ Short Jumper VCC/PB4/GND ดังรูปตอไปนี้ 
 
 
 
 
 

                     (ก)                 (ข)                 (ค) 
(ก) ทํางานในโหมด Master         
(ข) กําหนดโหมดการทํางานไดจากโปรแกรม        
(ค) ทํางานในโหมด Slave 

รูปแสดง การกําหนด jumper  ใหกับพอรต SPI เพื่อเลือกโหมดการทํางาน 

0 1 1 1 A2 A1 A0 R/W
บิต7 บิต6 บิต5 บิต4 บิต3 บิต2 บิต1 บิต0
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จากรูปขางบนอธิบายไดวา หากเราตองการให CPU ที่มาตอกับขั้วนี้ทํางานในโหมด Master ก็ใหทํา
การเลือก Jumper ดังรูป (ก)  และถาเราเลือก Jumper ดังรูป (ข) จะทําใหเราสามารถเขียนโปรแกรมควบคุม 
CPU ไดวาเราตองการใหมันทํางานอยูในโหมดSlave หรือ Master แตถาเราเสียบ jumper ดังรูป (ค) จะเปนการ
กําหนดให CPU ทํางานในโหมด Slave   

รูปตอไปนี้จะเปนการอธิบายถึงการตอ CPU 2 ตัวเขาดวยกันโดยการสื่อสารขอมูลจะทําผานพอรต SPI 
ซึ่งจากรูปทานจะพบวาขา MOSI (Master Out Slave In) ของตัวมาสเตอรตออยูกับขา MOSI ของอุปกรณ 
สเลฟ  และขา MISO (Master In Slave Out) ของตัวมาสเตอรจะตออยูกับ MISO ของตัว Slave สวนขา SCK 
ของ CPU ทั้งสองตัว จะตอเขากับ clock ตัวเดียวกันเพื่อใหเกิดการซิงโครนัสในการสงขอมูล ขา ss  ของตัวมาส
เตอรจะตออยูกับ VCC สวนขา ss ของตัวสเลฟจะตออยูกับ GND  8 Bit Shift Register เปนรีจิสเตอรที่อยูใน 
CPU ทําหนาที่ในการเก็บขอมูลและเลื่อนขอมูลเขาออก ดังนั้นเมื่อเราตอ CPU ดังรูป การทํางานของมันจะเปน
เหมือนการนํารีจิสเตอร 8 บิต 2 ตัวมาตอกันเปนรีจิสเตอรขนาด 16 บิต 1 ตัว นั่นเอง  

 
 
 
 
 
 

 
  
          รูปแสดง การตอ CPU 2 ตัวเขาดวยกันผาน SPI Port 
 
การสื่อสารอนุกรมแบบ RS232  

ในกรณีนี้จะตองทําการติดตั้งไอซี Line Driver เพื่อเปล่ียนระดับสัญญาณทางไฟฟาของขาสัญญาณ
สําหรับ รับ-สง ขอมูลแบบ TTL ของ CPU (RX และ TX) ใหเปนระดับสัญญาณทางไฟฟาแบบ RS232 (±12V)  
โดยการติดตั้งไอซีเบอร MAX232 เพื่อทําหนาที่เปล่ียนระดับสัญญาณ TTL จากขาสัญญาณสงขอมูล (TX) ของ 
CPU ใหเปนระดับสัญญาณ ±12V สําหรับสงไปยังขารับสัญญาณ (RX) ของอุปกรณภายนอก และในทางกลับ
กัน ก็จะทําหนาที่เปล่ียนระดับสัญญาณสง (TX) แบบ RS232 (±12V) จากอุปกรณภายนอก ใหกลับมาเปน
ระดับ TTL เพื่อสงใหกับขารับขอมูล (RX) ของ CPU ดวย โดยเมื่อเปล่ียนระดับสัญญาณในการรับสงขอมูลจาก 
TTL มาเปนแบบ RS232 นี้แลวจะทําใหสามารถทําการ รับ-สง ขอมูลกับอุปกรณภายนอกที่ใชระดับสัญญาณ
ทางไฟฟาในการ รับ-สง แบบเดียวกัน (RS232) ไดไกลขึ้น ประมาณ 50ฟุต หรือ ประมาณ 15 เมตร โดยสามารถ
ทําการ รับ-สง ขอมูลกับอุปกรณตางๆไดในลักษณะของตัวตอตัว (Point-to-Point) เทานั้น 

สําหรับสายสัญญาณที่จะนํามาใชสําหรับทําการสื่อสารแบบ RS232 นั้น จะใชสัญญาณเพียง 2-3 เสน 
เทานั้น ทั้งนี้ขึ้นอยูกับความตองการในการสื่อสารวาตองการสื่อสารแบบทิศทางเดียวหรือสองทิศทาง 

- การส่ือสาร RS232 แบบสองทิศทาง ซึ่งจะมีทั้งการรับขอมูลและสงขอมูลไปมา ระหวางดานรับ
และดานสง โดยในกรณีนี้จะตองใชสายสัญญาณจํานวน 3 เสน สัญญาณรับขอมูล (RXD) 
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สัญญาณสงขอมูล(TXD) และสัญญาณอางอิง (GND) โดยในการเชื่อมตอสายนั้นจะตองทําการ
สลับสัญญาณกับอุปกรณปลายทางดวย คือ สัญญาณสง (TXD) จากบอรด CP-AVR จะตองตอ
เขากับสัญญาณรับ  (RXD) ของอุปกรณ  และสัญญาณสง (TXD) จากอุปกรณก็ตองตอกับ
สัญญาณรับ (RXD) ของบอรด สวนสัญญาณอางอิง (GND) จะตองตอตรงถึงกัน จึงจะสามารถ
ทําการ รับ-สง ขอมูลกันได 

- การส่ือสาร RS232 แบบทิศทางเดียว ซึ่งอาจเปนการรอรับขอมูลจากดานสงเพียงอยางเดียว 
หรืออาจเปนการสงขอมูลออกไปยังปลายทางเพียงอยางเดียว โดยไมมีการโตตอบขอมูลซึ่งกันและ
กัน ซึ่งวิธีนี้จะใชสายสัญญาณเพียง 2 เสน เทานั้น โดยถาเปนทางดานสง ก็จะตอเพียงสัญญาณ
สง (TXD) และสัญญาณอางอิง (GND) แตถาเปนทางดานรับ ก็จะตอเพียงสัญญาณรับ (RXD) 
และ สัญญาณอางอิง (GND) เทานั้น  

 
โดยขั้วตอของสัญญาณ RS232 ของบอรด CP-AVR ทั้ง 3 รุน นั้น จะเปนจุดเชื่อมตอของสัญญาณ รับ-

สง ขอมูล ที่เปล่ียนระดับสัญญาณเปนแบบ RS232 แลว ซึ่งจะมีลักษณะเปนแบบขั้ว CPA ขนาด 4 PIN สําหรับ
ใชเปนจุดเชื่อมตอสัญญาณ รับ-สง ขอมูลกับอุปกรณภายนอก โดยมีลักษณะการจัดเรียงสัญญาณดังนี้ 

 
 
 
 
 

รูปแสดง ขั้วตอสัญญาณ RS232 ของบอรด CP-AVR V3.0/V3.0 EXP/V4.0 
 

 ซึ่งจะเห็นไดวาขั้วตอสัญญาณ RS232 ของบอรดนั้น จะมีทั้งหมด 4 เสน แตในการ รับ-สง ขอมูลแบบ
ปรกตินั้น จะใชสัญญาณเพียงแค 3 เสน คือ RXD,TXD และ GND เทานั้น สวน +VCC ซึ่งเปนไฟเลี้ยงวงจร +5V 
นั้น จะไมจําเปนตองนํามาใชในการสื่อสารกันแตอยางใด โดย +VCC หรือ +5V นี้ จะออกแบบเผื่อไวในกรณีที่
อุปกรณปลายทางเปนวงจรขนาดเล็กและไมสะดวกที่จะหาแหลงจายไฟใหกับอุปกรณปลายทางดวย ก็อาจตอ
ไฟเลี้ยงวงจร +VCC นี้ออกไปใหกับอุปกรณปลายทางดวยก็ไดเชนกัน 

 
****หมายเหตุ*** สําหรับไอซี Line Drive แบบ RS232 นั้น จะจัดเปนอุปกรณมาตรฐานของบอรดใน

ตระกูล CP-AVR ซึ่งจะมีติดตั้งใหไปกับบอรดอยูแลว ผูใชไมตองจัดหาเพิ่มเติม แตพึงระลึกไวเสมอวา จะตองทํา
การติดตั้งไอซี Line Driver สําหรับเลือกชนิดสัญญาณทางไฟฟาของการสื่อสารอนุกรม ไดเพียงอยางใดอยาง
หนึ่งเทานั้น เชน เมื่อเลือกติดตั้งไอซี Line Driver เปนแบบ RS232 โดยการติดตั้ง MAX232 ในบอรดแลว จะตอง
ไมติดตั้งไอซี Line Driver แบบอื่น เชน RS422 หรือ RS485 เขาไปดวย เพราะจะทําใหไมสามารถรับสงขอมูลกัน
ไดอยางถูกตอง ผูใชตองเลือกติดตั้งไอซี Line Driver อยางใดอยางหนึ่งเทานั้น 
 
 

+VCC

RXD

TXD

GND
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การสื่อสารอนุกรมแบบ RS422  
ในกรณีนี้จะตองทําการติดตั้งไอซี Line Driver เบอร 75176 หรือ MAX3088 จํานวน 1-2 ตัว เพื่อทํา

หนาที่เปล่ียนระดับสัญญาณไฟฟาในการ รับ-สง แบบ TTL จาก CPU ใหเปนระดับสัญญาณแบบ Balance Line 
เพื่อ รับ-สงสัญญาณกับอุปกรณที่มีระดับสัญญาณทางไฟฟาเปนแบบ Balance Line เหมือนกัน โดยถาตองการ
ใชการสื่อสารแบบ 2 ทิศทาง ก็จะตองติดตั้งไอซี Line Driver จํานวน 2 ตัว โดยแบงเปนตัวแปลงสัญญาณทาง
ดานรับ 1 ตัว และตัวแปลงสัญญาณดานสงอีก 1 ตัว แตถาตองการสื่อสารแบบทิศทางเดียวก็อาจทําการติดตั้ง
ไอซี Line Driver เพียงตัวเดียว โดยถาตองการใหเปนฝายรับขอมูลเพียงอยางเดียวก็ใหติดตั้งไอซี Line Driver 
เฉพาะในตําแหนงของ “RXD/422” เพียงตัวเดียว แตถาตองการใหเปนฝายสงขอมูลเพียงอยางเดียวก็ใหทําการ
ติดตั้งไอซี Line Driver เฉพาะในตําแหนง “TXD/485” เพียงตัวเดียวเทานั้น 

ซึ่งการสื่อสารแบบ RS422 นี้ สามารถนําไปทดแทนการสื่อสารแบบ RS232 ไดทันที โดยไมตองดัด
แปลงหรือแกไขโปรแกรมเลย ซึ่งการสื่อสารโดยใชระดับสัญญาณในการ รับ-สง แบบ RS422 นี้จะมีขอดี คือ
สามารถทําการสื่อสารกันไดในระยะทางที่ไกลขึ้นกวาแบบ RS232 มาก กลาวคือ สามารถจะทําการ รับ-สง ขอ
มูลกันไดในระยะทางประมาณ 4000 ฟุต หรือ 1200 เมตร เลยทีเดียว เพียงแตตองใชสายสัญญาณที่ออกแบบ
มาสําหรับรองรับการใชงานในดานการสื่อสารแบบนี้โดยเฉพาะ ซึ่งไดแก สายสัญญาณแบบ UTP (Un-Shiled 
Twist Pair) หรือ STP (Shiled Twist Pair) โดยการสื่อสารดวยระดับสัญญาณทางไฟฟาแบบ RS422 นี้ ถาเปน
การสื่อสารแบบ 2 ทิศทาง คือ ทั้งรับขอมูลและสงขอมูล จะสามารถทําการรับสงขอมูลกับอุปกรณตางๆไดใน
ลักษณะของตัวตอตัว (Point-to-Point) เหมือนกับ RS232  ทุกประการ แตในกรณีที่เปนการสื่อสารแบบทิศทาง
เดียวนั้น สามารถจะทําการตอขนานสัญญาณทางดานรับ จํานวนหลายๆจุด เขากับสัญญาณสงเพียงจุดเดียวได 
โดยถาเลือกใชไอซี Line Driver เบอร 75176 จะสามารถตอขนานจํานวนอุปกรณสําหรับดานรับขอมูลได
ประมาณ 32จุด แตถาเลือกใชไอซี Line Driver เบอร MAX3088 นั้น จะสามารถตอขนานจํานวนอุปกรณทาง
ดานรับขอมูลไดมากถึง 256 จุด เลยทีเดียว แตถาเปนอุปกรณทางดานสงนั้น จะไมสามารถนํามาตอขนาน
สัญญาณสงขอมูลเขาดวยกันมากกวา 1 จุด เหมือนทางดานฝายรับได ซึ่งวงจร Line Driver แบบ RS422 นี้จะมี
อยูเฉพาะในบอรดรุน CP-AVR V4.0 เทานั้น  

สําหรับลักษณะของขั้วตอของสัญญาณ RS422 นั้น จะเปนแบบ CPA ขนาด 6 PIN ดังรูป โดยในการ
ส่ือสารกันนั้น จะใชสายสัญญาณในการ รับ-สง ขอมูลกัน จํานวน 4 เสนสัญญาณ คือ สัญญาณในการรับขอมูล 
จํานวน 2 เสน คือ RXA (RX+) และ RXB (RX-) และสัญญาณในการสงขอมูลอีก 2 เสน คือ TXA (TX+) และ 
TXB (TX-) ซึ่งในการตอสัญญาณนั้น จะตองทําการตอสัญญาณในลักษณะของการสลับกัน คือ สัญญาณสงจะ
ตองตอเขากับสัญญาณรับ นั่นก็คือ สัญญาณ RXA (RX+) จะตองตอกับ TXA (TX+) สวน RXB (RX-) ก็จะตอง
ตอกับ TXB (TX-) ดวยเชนกัน โดยลักษณะของขั้วตอสัญญาณ RS422 เปนดังรูป 
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การสื่อสารอนุกรมแบบ RS485  
 ในการสื่อสารแบบ RS485 นี้จะมีคุณสมบัติของสัญญาณทางไฟฟาเหมือนกับ RS422 ทุกประการ 
เพียงแตวาในการสื่อสารแบบ RS485 นี้จะใชสายสัญญาณในการรับสงขอมูลกันเพียง 2 เสน เทานั้น แตจะมี
ความพิเศษกวาแบบ RS422 ตรงที่ ทิศทางของสัญญาณจะสามารถปรับเปล่ียนไดจากโปรแกรม กลาวคือ 
สัญญาณทั้ง 2 เสน นี้สามารถจะสลับหนาที่เปนดานสง และ เปนดานรับได ตามตองการ โดยการควบคุมจาก 
CPU โดยจากบอรด CP-AVR V4.0 นั้น จะกําหนดใหสัญญาณ PD7 ทําหนาที่สําหรับควบคุมทิศทางของขอมูล
วาจะใหเปนรับหรือสง โดยถาควบคุมให PD7 มีสภาวะเปน “1” จะเปนการกําหนดทิศทางใหเปนฝายสงขอมูล 
แตถาสภาวะของ PD7 เปน “0” จะเปนการกําหนดทิศทางใหเปนฝายรับขอมูล ซึ่งจากคุณสมบัติขอนี้จะทําให
การสื่อสารแบบ RS485 สามารถทําการตอขนานอุปกรณรวมกันในสายสงเดียวกันไดจํานวนหลายๆจุด โดยถา
ใชไอซี Line Driver เบอร 75176 จะสามารถตอขนานอุปกรณกันได จํานวน 32 จุด แตถาเลือกใชไอซี Line 
Driver เบอร MAX3088 แลวจะสามารถตอขนานอุปกรณในสายคูเดียวกันไดมากถึง 256 จุด เลยทีเดียว แตมีขอ
แมวา เมื่อมีการตออุปกรณขนานกันในสายสัญญาณคูเดียวกันมากกวา 2 จุดแลว จะตองเขียนโปรแกรมควบคุม
ใหมีการสงขอมูลออกมาในสายครั้งละ 1  จุดเทานั้น เพราะถามีการกําหนดทิศทางของขอมูลใหเปนสงในเวลา
เดียวกันมากกวา 1 จุดแลวจะทําใหเกิดการชนกันของขอมูลและไมสามารถสื่อสารกันไดอยางถูกตอง 
 โดยเมื่อตองการใชวิธีการสื่อสารแบบ RS485 นี้ จะตองทําการติดตั้งไอซี Line Driver เบอร 75176 
หรือ MAX3088 ในตําแหนงของ “TXD/485” เพียงตัวเดียว พรอมกับเลือกกําหนดเปนแบบ RS485 ดังนี้ 

- ทําการเลือก Jumper สําหรับเลือก “422/485” ไวทางดาน 485 (RS485) 
- ทําการเลือก Jumper “F/H” ไวทางดาน H (Half Duplex) 
- ทําการ Short Jumper สําหรับตอตัวตานทาน Fail Safe Resister คือ “TL” ไว 
- ทําการ Short Jumper  สําหรับตอตัวตานทาน Fail Safe Resister คือ “TH” ไว 
- สายสัญญาณที่ใชจะตอจาก TXB(TX-) และ TXA(TX+) เพียง 2 เสน ออกไปใชงาน 
ซึ่งในการสื่อสารขอมูลแบบ RS485 นี้ จะตองเขียนโปรแกรมขึ้นมารองรับการสื่อสารโดยเฉพาะ เนื่อง

จากทิศทางของขอมูลสามารถจะกําหนดจากโปรแกรมไดโดยตรง ซึ่งการสื่อสารวิธีนี้จะมีขอดีคือ ใชสาย
สัญญาณในการรับสงนอยเสน แตจะเสียเวลาในการสื่อสารมากกวาวิธีอื่นๆ เนื่องจากวา การส่ือสารแบบนี้จะไม
สามารถทําการรับและสงขอมูลในเวลาเดียวกันได แตจะตองใชวิธีการ ผลัดกันรับ ผลัดกันสง แทน ซึ่งในความ
เปนจริงแลวในปจจุบันนี้ ราคาของสายสัญญาณแบบ 2 เสน และ 4 เสน แทบจะไมมีความแตกตางกันเลย ดังนั้น
เพื่อลดความยุงยากในการเขียนโปรแกรมสําหรับควบคุมการรับสงขอมูลของ CPU ขอแนะนําใหเลือกใชวิธีการ
ส่ือสารแบบ RS422 จะงายและสะดวกรวดเร็วกวากันมาก 
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การกําหนด Jumper สําหรับการสื่อสารแบบ RS422/485 
 เนื่องจากวงจร Line Driver ของพอรตส่ือสารอนุกรมของบอรดนั้น ออกแบบใหผูใชสามารถเลือก
กําหนดไดหลายแบบ ดังนั้น จึงตองมีการใช Jumper สําหรับเปนตัวเลือกรูปแบบการสื่อสารรวมดวย โดยจะมี 
Jumper ที่เกี่ยวของกับการใชงานการสื่อสารแบบ RS422 และ RS485 ดังตอไปนี้ คือ 

- Jumper 422/485 เปน Jumper สําหรับเลือกกําหนดการทํางานของไอซี Line Driver ในตําแหนง 
TXD/485 ใหทํางานเปนแบบ RS422 หรือ RS485 โดยถาตองการใหเปนแบบ RS422 จะตอง
กําหนด Jumper ไวทางดาน “422” ซึ่งจะทําใหไอซี Line Driver ตําแหนง “TXD/485” ทําหนาที่
เปนฝายสงขอมูลเพียงอยางเดียว แตถาตองการใชงานแบบ RS485 จะตองกําหนด Jumper ไว
ทางดาน “485” เพื่อกําหนดใหไอซี Line Driver ในตําแหนง “TXD/485” ทําหนาที่เปนทั้งฝายรับ
และฝายสง ตามการควบคุมของสัญญาณ PD7 

- Jumper F/H (Full/Half) เปน Jumper ใชสําหรับเลือกกําหนดรูปแบบการสื่อสารใหเปนแบบ Full 
Duplex (F) หรือ  Half Duplex (H) โดยถาตองการใชงานแบบ  RS422 จะตองเลือกกําหนด 
Jumper นี้ไวทางดาน F(Full Duplex) แตถาตองการใชงานเปนแบบ RS485 จะตองเลือกกําหนด 
Jumper นี้ไวทางดาน H(Half Duplex) แทน 

- Jumper RL เปน Jumper ใชสําหรับเลือกกําหนดการเชื่อมตอ ตัวตานทานสําหรับทําหนาที่คง
สถานะของสัญญาณ RXB (RX-) หรือ Fail Safe Resister เพื่อใหสัญญาณ RXB (RX-) มีสภาวะ
แนนอนเมื่อไมมีการสงสัญญาณใดๆออกมาในสายเลย ซึ่งถาหากวามีการตอสายสัญญาณระยะ
ทางไกลๆหรือมีการตอสายระยะทางไกลๆแตไมไดมีการสงขอมูลออกมาในสายตลอดเวลาแลว 
ควรที่จะทําการ Short Jumper นี้ไวดวยเสมอ โดยเฉพาะอยางยิ่งตัวอุปกรณที่อยูในตําแหนงตน
สายและปลายสายควรทําการ Short Jumper นี้ไวเสมอ สวนอุปกรณที่อยูในตําแหนงอื่นๆที่มี
ระยะไมไกลจากจุดตนสายและปลายสายมากนักก็อาจ Open Jumper นี้ออกก็ได แตอยางนอยที่
สุด ควรมีการ Short Jumper นี้ใหกับอุปกรณที่ตอรวมอยูในสายสัญญาณจํานวน 1 จุดเสมอ 

- Jumper RH เปน Jumper ใชสําหรับเลือกกําหนดการเชื่อมตอ ตัวตานทานสําหรับทําหนาที่คง
สถานะของสัญญาณ  RXA (RX+) หรือ  Fail Safe Resister เพื่ อให สัญญาณ  RXA (RX+) มี
สภาวะแนนอนเม่ือไมมีการสงสัญญาณใดๆออกมาในสายเลย  ซึ่งถาหากวามีการตอสาย
สัญญาณระยะทางไกลๆหรือมีการตอสายระยะทางไกลๆแตไมไดมีการสงขอมูลออกมาในสาย
ตลอดเวลาแลว ควรที่จะทําการ Short Jumper นี้ไวดวยเสมอ โดยเฉพาะอยางยิ่งตัวอุปกรณที่อยู
ในตําแหนงตนสายและปลายสายควรทําการ Short Jumper นี้ไวเสมอ สวนอุปกรณที่อยูใน
ตําแหนงอื่นๆที่มีระยะไมไกลจากจุดตนสายและปลายสายมากนักก็อาจ Open Jumper นี้ออกก็
ได แตอยางนอยที่สุด ควรมีการ Short Jumper นี้ใหกับอุปกรณที่ตอรวมอยูในสายสัญญาณ
จํานวน 1 จุดเสมอ 

- Jumper RZ เปน Jumper สําหรับเลือกกําหนดการตอตัวตานทาน RZ เพื่อชดเชย คาความตาน
ทานของสายสัญญาณ (Impedance) ทางดานรับ ซึ่งถาหากวามีการตอสายสัญญาณในการรับ
สงเปนระยะทางไกลๆแลวก็ควรทําการ Short Jumper นี้ไวดวยเนื่องจากเมื่อสายมีความยาว
มากๆจะเกิดคาความตานทานในสายขึ้น ดังนั้นจึงตองทําการตอคาความตานทานจากภายนอก
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ไปชดเชยคาความตานทานของสายสัญญาณดวย โดยเมื่อทําการ Short Jumper ตําแหนง RZ นี้
ไวก็จะเปนการตอตัวตานทานครอมระหวาง RXA (RX+) และ RXB (RX-) ไว แตถาหากวาตอสาย
สัญญาณในระยะทางที่ไมไกลมากนัก ก็ใหทําการ Open Jumper นี้ออกก็ได 

- Jumper TL เปน Jumper ใชสําหรับเลือกกําหนดการเชื่อมตอ ตัวตานทานสําหรับทําหนาที่คง
สถานะของสัญญาณ TXB (TX-) หรือ Fail Safe Resister เพื่อใหสัญญาณ TXB (TX-) มีสภาวะ
แนนอนเมื่อไมมีการสงสัญญาณใดๆออกมาในสายเลย ซึ่งถาหากวามีการตอสายสัญญาณระยะ
ทางไกลๆหรือมีการตอสายระยะทางไกลๆแตไมไดมีการสงขอมูลออกมาในสายตลอดเวลาแลว 
ควรที่จะทําการ Short Jumper นี้ไวดวยเสมอ โดยเฉพาะอยางยิ่งเมื่อใชงานเปนแบบ RS485 หรือ
ใชงานเปนตัวอุปกรณที่อยูในตําแหนงตนสายและปลายสายควรทําการ Short Jumper นี้ไวเสมอ 
สวนอุปกรณที่อยูในตําแหนงอื่นๆที่มีระยะไมไกลจากจุดตนสายและปลายสายมากนักก็อาจ 
Open Jumper นี้ออกก็ได แตอยางนอยที่สุด ควรมีการ Short Jumper นี้ใหกับอุปกรณที่ตอรวม
อยูในสายสัญญาณจํานวน 1 จุดเสมอ 

- Jumper TH เปน Jumper ใชสําหรับเลือกกําหนดการเชื่อมตอ ตัวตานทานสําหรับทําหนาที่คง
สถานะของสัญญาณ TXA (TX+) หรือ Fail Safe Resister เพื่อใหสัญญาณ TXA (TX+) มีสภาวะ
แนนอนเมื่อไมมีการสงสัญญาณใดๆออกมาในสายเลย ซึ่งถาหากวามีการตอสายสัญญาณระยะ
ทางไกลๆหรือมีการตอสายระยะทางไกลๆแตไมไดมีการสงขอมูลออกมาในสายตลอดเวลาแลว 
ควรที่จะทําการ Short Jumper นี้ไวดวยเสมอ โดยเฉพาะอยางยิ่งเมื่อใชงานเปนแบบ RS485 หรือ
ใชงานเปนตัวอุปกรณที่อยูในตําแหนงตนสายและปลายสายควรทําการ Short Jumper นี้ไวเสมอ 
สวนอุปกรณที่อยูในตําแหนงอื่นๆที่มีระยะไมไกลจากจุดตนสายและปลายสายมากนักก็อาจ 
Open Jumper นี้ออกก็ได แตอยางนอยที่สุด ควรมีการ Short Jumper นี้ใหกับอุปกรณที่ตอรวม
อยูในสายสัญญาณจํานวน 1 จุดเสมอ 

- Jumper TZ เปน Jumper สําหรับเลือกกําหนดการตอตัวตานทาน TZ เพื่อชดเชย คาความตาน
ทานของสายสัญญาณ (Impedance) ทางดานสง ซึ่งถาหากวามีการตอสายสัญญาณในการรับ
สงเปนระยะทางไกลๆแลวก็ควรทําการ Short Jumper นี้ไวดวยเนื่องจากเมื่อสายมีความยาว
มากๆจะเกิดคาความตานทานในสายขึ้น ดังนั้นจึงตองทําการตอคาความตานทานจากภายนอก
ไปชดเชยคาความตานทานของสายสัญญาณดวย โดยเมื่อทําการ Short Jumper ตําแหนง TZ นี้
ไวก็จะเปนการตอตัวตานทานครอมระหวาง TXA (TX+) และ TXB (TX-) ไว แตถาหากวาตอสาย
สัญญาณในระยะทางที่ไมไกลมากนัก ก็ใหทําการ Open Jumper นี้ออกก็ได 

 
***ขอสังเกตุ*** จะเห็นไดวาวงจร Line Driver ทั้งแบบ RS422 และ RS485 นั้นจะมีความใกลเคียง 

กันมาก แตมีขอแตกตางอยางหนึ่งที่เห็นไดชัดเจนที่สุด คือ ถาเปนแบบ RS422 จะไมสามารถสั่งเปล่ียน ทิศทาง
การรับสงขอมูลดวยโปรแกรมได ซึ่งทิศทางการรับสงจะกําหนดตายตัวจากวงจร แตถาเปนแบบ RS485 นั้น จะ
สามารถสั่งควบคุมทิศทางการรับสงจากโปรแกรมไดวาจะใหทําหนาที่เปนฝายรับ หรือฝายสง อยางใดอยางหนึ่ง
ไดตามตองการได 
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การใชงานโปรแกรม w95s8535v5 และ w95mega163v1 สําหรับดาวนโหลดขอมูล 
กอนการ Download โปรแกรมทุกครั้งเราควรจะตรวจสอบใหแนใจกอนวา ไดจายไฟเลี้ยงใหกับบอรด

ถูกตองแลว ซี่งจะสังเกตไดจาก LED ตัวสีแดงจะสวางตลอดเวลาที่เราจายไฟใหกับบอรดทั้ง 3 รุน สําหรับไฟ
เล้ียงนั้นจะเปนไฟ AC หรือ DC ก็ไดแตควรจะมีระดับของแรงดันอยูระหวาง 9 -12 V และกระแส 800 –1000 
mA  ตอไปใหเราเชื่อมตอพอรตปริ๊นเตอร(Printer Port)เขากับบอรดทดลองดวยสายดาวนโหลด ET-PSPI โดยใน
การเลือกพอรตปริ๊นเตอรสําหรับการดาวนโหลดขอมูลนั้น หากคอมฯของทานมีพอรตปริ๊นเตอรมากกวา 1 พอรต
ทานก็สามารถเลือกพอรตปริ๊นเตอรพอรตใดก็ไดสําหรับตอสายดาวนโหลด เมื่อตอสายดาวนโหลดขอมูลเสร็จ
แลว ใหทานทําการเปดโปรแกรม w95s8535v5 ถาทานใช CPU เบอร 90S8535 แตถาหากทานใชเบอร 
ATmega163 ก็ใหทานเลือกเปดโปรแกรม w95mega163v1 ขึ้นมาแทน ซึ่งโปรแกรมทั้งสองตัวนี้เปนโปรแกรมที่
จะใชในการดาวนโหลดขอมูลลงไปที่ตัว CPU นั่นเอง โปรแกรม w95s8535v5 และ w95mega163v1 จะมีฟงก
ชั่นที่ทานตองทําการกําหนดกอนเริ่มทําการดาวนโหลดโปรแกรมดังนี้ 
 
ฟงกชั่น Lpt Port 

กอนการใชงานโปรแกรม w95s8535v5 และ w95mega163v1 ในครั้งแรกสุด เราจะตองทําการเลือก
พอรตปริ๊นเตอรที่เราจะใชในการดาวนโหลดโปรแกรมกอน โดยทานสามารถคลิกเลือกพอรตปริ๊นเตอรไดในกรอบ 
Lpt Port ซึ่งในกรอบนี้จะมีตัวเลือก 3 ตัวดวยกันนั่นคือ Lpt1, Lpt2 และ Lpt3 ซึ่งถาหากเราเลือกพอรตไมตรง
และพยายามที่จะทําการโปรแกรมขอมูล โปรแกรมจะแสดงกลองขอความผิดพลาดขึ้นมา วิธีแกก็คือใหเรากดปุม 
Ignore และโปรแกรมจะแสดงกลองขอความ “Error! Please check your CPU, power supply and printer 
port.”  ใหเรากดปุม OK จากนั้นก็เขาไปเลือกพอรตปริ๊นเตอรใหมใหถูกตอง โปรแกรมก็จะสามารถทํางานได  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปแสดง โปรแกรมดาวนโหลด w95s8535v5 
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      รูปแสดง โปรแกรมดาวนโหลด w95mega163v1 

 
ฟงกชั่น Delay  

ในการดาวนโหลดขอมูลลงไปที่ไมโครคอนโทรลเลอรนั้นเนื่องจากความเร็ว CPU ของคอมพิวเตอรของ
ผูใชงานมีความเร็วแตกตางกันไป ดังนั้นเพื่อใหการดาวโหลดขอมูลอยูในมาตรฐานความเร็วที่สามารถสื่อสารขอ
มูลกับไมโครคอนโทรลเลอรได เราจึงตองเพิ่มฟงกชั่น Delay ขึ้นมาเพื่อใหผูใชทําการปรับความเร็วในการสงขอ
มูลผานพอรตปริ๊นเตอรใหชาลง เราขอแนะนําใหทานทดลองดาวนโหลดขอมูลกอน หากการดาวนโหลดขอมูลไม
สามารถทําได ทานจึงคอยๆเพิ่มคาในชอง Bit กับ Byte ขึ้นไปเรื่อยๆจนมันสามารถดาวนโหลดขอมูลไดโดยไม
เกิดการผิดพลาด  
 
ฟงกชั่น Write Fuse(เฉพาะ w95mega163v1) 
 ฟงกชั่นนี้จะใชในการโปรแกรม Fuse bit ไบตสูงและไบตต่ํา สําหรับขอมูลรายละเอียดของ Fuse bit ทั้ง
สองไบตนี้ทานสามารถศึกษาไดจาก datasheet ของ CPU ฟงกชั่นนี้จะใชไดแตเฉพาะกับ ATmega163 เทานั้น 
เนื่องจาก CPU เบอรนี้มี Fuse bit หลายตัวที่จําเปนตอการทํางาน 
 เราควรจะทําการโปรแกรม Fuse Bits กอนการโปรแกรม Lock Bit และเมื่อเราทําการ Erase  CPU จะ
ไมมีผลกระทบใดๆ ตอ Fuse Bits ดังนั้นหากเราตองการเปลี่ยนสถานะของมันเราจะทําโดยการโปรแกรมคาใหม
ลงไปใหกับมันแทน 
 

***ขอสังเกตุ*** สําหรับการใช CPU เบอร ATmega163 ในครั้งแรกกับบอรดทั้ง 3 รุน เราขอแนะนําให
ทานทําการโปรแกรม Fuse Bits Low กอน โดยการพิมพ FA ลงไปที่ชอง Bits Low และกดที่ปุม Bits Low การ
กระทําเชนนี้ก็เพื่อใหเราสามารถใชคริสตอล 8 MHz ที่ตออยูภายนอกได แตหากทานไมทําการโปรแกรม Fuse 
Bits Low กอน แตนํามันไปใชงานเลย CPU จะใชสัญญาณนาฬิกาที่อยูภายในตัวมันซึ่งจะมีคาประมาณ 1 MHz   
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ฟงกชั่น Security 
 เราจะใชฟงกชั่นนี้เพื่อการโปรแกรม Lock Bit1 และ 2 (เมื่อLock Bit ใดถูกโปรแกรม Lock Bit นั้นจะมี
คาเปน 0) ซึ่งการโปรแกรม Lock Bit1 จะทําใหเราไมสามารถทําการโปรแกรมขอมูลลงบนหนวยความจําแบบ
แฟลชและEEPROMได สวนการโปรแกรม Lock Bit2 จะใหผลเหมือนกับการโปรแกรม Lock Bit1 และนอกจาก
นั้นแลวเรายังจะไมสามารถทําการ Verify หรือ อานขอมูลไดดวย 
 อยางไรก็ตามสถานะของ Lock bit1 และ 2 จะเปลี่ยนเปน 1( 1 ในที่นี้หมายถึงการไมไดถูกโปรแกรม) 
ทุกครั้งเมื่อเราทําการ Erase ขอมูล  
 
ปุม Open Hex File 
 กอนเราจะทําการเขียนโปรแกรมลงไปที่หนวยความจําแฟลชของไมโครคอนโทรลเลอรทุกครั้ง แนนอนที่
สุดเราจะตองมีขอมูลกอน ดังนั้นปุมนี้จะใชสําหรับนําขอมูลที่อยูในหนวยความจําถาวรเชน ฮารดดิสก มาเก็บไว
ในหนวยความจําชั่วคราวของเครื่องเพื่อรอที่จะถูกเขียนลงไปยังหนวยความจําแฟลชของไมโครคอนโทรลเลอร 
โดยขอมูลที่เราจะทําการอานเขามาเก็บในหนวยความจําชั่วคราวนี้จะตองอยูในรูปแบบภาษาเครื่องหรือที่เรา
เรียกวา Hex File(*.hex) เทานั้น สําหรับในคูมือการใชงานเลมนี้จะแนะนําการใชโปรแกรม AStudio4 AVR 
Assembler เพื่อทําการคอมไพลไฟลแอสเซมบลี (*.asm) ใหเปน Hex File อีกทีหนึ่ง 
 
ปุม Erase 
 ปุมนี้จะใชในการเคลียรหนวยความจําแบบแฟลชของ CPU ใหพรอมสําหรับการรับขอมูลใหม การ 
Erase ทุกครั้งจะทําใหหนวยความจําแบบแฟลชมีขอมูลเปน FFh ทั้งหมด และเราจะตองทําการ Erase ขอมูลทุก
ครั้งกอนการโปรแกรมขอมูลชุดใหมลงไป 
 
ปุม Blank 
  ปุมนี้จะใชในการตรวจสอบขอมูลที่อยูในหนวยความจําแบบแฟลชวามีขอมูลเปน FF หรือหนวยความ
จําถูกเคลียรทั้งหมดหรือไม หากพบวาขอมูลในหนวยความจําไมเทากับ FF มันจะแสดงกลองขอความเล็กๆ วา 
Not Blank ในการใชงานปกติเราไมมีความจําเปนตองใชปุมนี้ 
 
ปุม Program 
 ปุมนี้จะใชในการโปรแกรมขอมูลลงไปเก็บยังหนวยความจําแฟลชของ CPU  
 
ปุม Verify 
 ปุมนี้จะใชในการตรวจสอบวาขอมูลที่อยูในหนวยความจําแบบแฟลชของ CPU นั้นเปนขอมูลตัวเดียว
กันกับที่อยูในหนวยความจําชั่วความที่อยูบนเครื่องคอมพิวเตอรหรือไม ถาไมเทากันมันจะแสดงกลองขอความ
บอกวา Verify Error ดังนั้นปุมนี้จึงมีไวสําหรับการตรวจสอบขอมูลที่เราไดโปรแกรมลงไปวามันไดถูกโปรแกรมลง
ไปอยางถูกตองหรือไมนั่นเอง 
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ปุม Auto 
 ปุมนี้จะทําการโปรแกรมขอมูลแบบอัตโนมัติ โดยมันจะเริ่มทําตั้งแตการ Erase, Blank, Program และ
ส้ินสุดที่ Verify ดังนั้นกอนที่เราจะกดปุมนี้ เราควรจะมีขอมูลอยูในหนวยความจําชั่วคราวกอนโดยทําการ Open 
Hex File เพื่อเลือกโปรแกรมที่เราตองการทําการโปรแกรมจากนั้นจึงกดปุม Auto 
 ในการกดปุม Erase, Blank, Program, Verify หรือ Auto หากการทํางานไมเกิดการผิดพลาด ทานจะ
สังเกตเห็น LED สีเขียวกระพริบ ซึ่งจะเปนตัวแสดงใหเราทราบวาขณะนี้ขอมูลกําลังถูกสงผานสาย MOSI  
 สําหรับโปรแกรม w95s8535v5 และ w95mega163v1 นี้สามารถทํางานบนระบบปฏิบัติการ 
Windows 95/98/ME ไดทันที สวนบนระบบปฏิบัติการ Windows NT/2000/XP นั้นผูใชงานจะตองเปดการ
ทํางานของพอรตปริ๊นเตอรกอนทานจึงจะสามารถทําการดาวนโหลดขอมูลได ในการเปดการทํางานของพอรต 
ปร๊ินเตอรบน Windows NT/2000/XP นั้น เพื่อความสะดวกเราขอแนะนําใหทานใชโปรแกรม User Port ซึ่งอยูใน
แผน CD-ROM  
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แนะนําการใชโปรแกรม Astudio4 (AVR assembler) 
 สําหรับในหัวขอนี้เราจะอธิบายถึงวิธีการใชงานโปรแกรม Astudio4 เวอรชั่น 4.05 อยางงาย นั่นคือเรา
จะอธิบายเฉพาะการใช text editer และวิธีการคอมไพลโปรแกรมเทานั้น แตในสวนอื่นเชนการ debug 
program, chip simulator หากทานใดสนใจก็สามารถศึกษาไดจากเมนู Help ของ Astudio4 
 สําหรับโปรแกรมนี้มันสามารถทํางานไดบนวินโดวส 9x/ME/NT/2000/XP ดังนั้นจึงไมมีปญหาใดๆ
สําหรับผูใชระบบปฏิบัติการที่ตางชนิดกัน การติดตั้งโปรแกรมก็ทําไดไมยาก โดยใหทานคลายไฟล Astudio4(zip 
file)ออกมา จากนั้นก็รันไฟล setup.exe และก็ทําตามขั้นตอนที่แนะนําไปเรื่อยๆ จนการติดตั้งเสร็จสมบูรณ ซึ่ง
หลังการติดตั้งโปรแกรมนี้มันก็พรอมที่จะทํางานทันทีโดยเราไมตองเสียเวลารีสตารตเครื่องใหม 
System requirement 

- โปรแกรมนี้รันบนระบบปฏิบัติการ windows 9x/ME/NT/2000/XP 
- ความเร็วของ CPU Intel Pentium 200 MHz 
- ความละเอียดหนาจอไมควรต่ํากวา 800x600 pixels 
- แรม 64 MB 
- ที่วางฮารดดิสก 15 MB ขึ้นไป 

 
การสรางไฟลโปรเจ็กต(*.aps)และไฟลแอสเซมบลี(*.asm) 

เมื่อการติดตั้งเสร็จสมบูรณแลว และเราเปดโปรแกรมนี้ขึ้นมา เราจะพบหนาตาง Welcome to AVR 
Studio4 ดังนี้ 
 
 

 
 

รูปแสดง หนาตาง Welcome to AVR Studio 4  
หนาตางนี้จะมีไวสําหรับใหเราสามารถทําการสรางโปรเจ็กตไฟลใหมหรือสามารถเปดโปรเจ็กตไฟลที่มี

อยูแลวได โปรเจ็กตไฟลจะมีนามสกุลเปน .aps สําหรับหนาตางนี้มันจะแสดงเปนอันดับแรกของการเปด
โปรแกรมทุกครั้ง หากเราไมตองการใหมันแสดงหนาตางนี้ เราสามารถทําไดโดยการคลิกเมาส 1 ครั้งที่เช็คบ็อก 
Show this dialog on open ที่อยูทางดานลางซายมือของหนาตางนี้ เพื่อเอาเครื่องหมายถูกที่กาอยูในเช็คบ็อก
ออกไป ซึ่งในการเปดโปรแกรมครั้งตอไปทานจะไมพบหนาตางนี้อีก และการเปดหรือสรางโปรเจ็กตใหมเรา
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สามารถทําไดผานทางออปชั่น Project ที่อยูในเมนูบารแทน แตสําหรับการอธิบายในที่นี้เราจะใชหนาตางนี้ใน
การสรางโปรเจ็กตใหม โดยใหทานคลิกที่ปุม Create New Project ซึ่งทานจะพบกับหนาตางใหมดังรูปตอไปนี้ 

 
 
 
 
 
 
 
 
 
 
 
 

   รูปแสดง หนาตางที่ใชในการสรางโปรเจ็กตไฟล 
 

ในขณะที่ทําการสรางไฟลโปรเจ็กต โปรแกรมสามารถที่จะสรางไฟล .asm ซึ่งเปนไฟลโปรแกรมภาษา
แอสเซมบลีไดพรอมกันไปในตัวโดยการกาเครื่องหมายถูกที่เช็คบ็อก Create Initial File จากนั้นใหเราพิมพชื่อ
ไฟลโปรเจ็กตที่ชองขอความ Project Name ในตัวอยางเราจะใชชื่อไฟลโปรเจ็กต rs232 และในระหวางที่เรา
พิมพชื่อไฟลโปรเจ็กต เราจะสังเกตุเห็นวาโปรแกรมจะพิมพชื่อไฟลโปรเจ็กตลงที่ชองขอความ Initial File ไปดวย 
ซึ่งจะเปนการสรางไฟลโปรแกรม .asm (ไฟลแอสเซมบลี) และหากเราตองการใหโปรแกรมสรางไฟล .asm ที่มีชื่อ
ตางจากชื่อไฟลโปรเจ็กต เราก็สามารถแกไขชื่อไฟล .asm ไดที่ชองขอความ Initial File นี้ 

ขอควรระวังในการตั้งชื่อไฟลแอสเซมบลีตางจากชื่อไฟลโปรเจ็กตนั่นก็คือ เมื่อเราทําการคอมไพลแลว
ไฟลตางๆ ที่โปรแกรมทําการสรางขึ้นมามันจะตั้งชื่อตามชื่อไฟลโปรเจ็กตเชน ถาเราตั้งชื่อไฟลโปรเจ็กตเปน 
Testproject และเราตั้งชื่อไฟลแอสเซมบลีชื่อ rs232 หลังการคอมไพลเราจะไดไฟล Testproject.hex ดังนี้
เปนตน 

หากเราไมตองการใหมันสรางไฟลโปรแกรม .asm ขึ้นในขณะที่เราสรางไฟลโปรเจ็กต เราสามารถทําได
โดยการคลิกที่เช็คบ็อก Create Initial File เพื่อเอาเครื่องหมายถูกที่กาอยูออก สวนที่เช็คบ็อก Create Folder จะ
เปนการสรางโฟลเดอรขึ้นมาเพื่อเก็บไฟลโปรเจ็คไวนั่นเอง ถัดลงมาที่ชองขอความ Location จะเปนตําแหนงของ

ไฟลโปรเจ็คที่จะถูกนําไปเก็บ ซึ่งเราสามารถเลือกที่จะเก็บไฟลที่ใหมไดโดยการคลิกที่ปุม  ที่อยูทายชองรับ
ความหรือพิมพชื่อ path ลงไปเลยก็ไดเชนเดียวกัน สําหรับในตัวอยางนี้เราจะเก็บไฟลโปรเจ็กตไวที่ C:\My 
Documents\avr และทําการสรางไฟล .asm ขึ้นพรอมกับการสรางไฟลโปรเจ็กตดวย 

เมื่อทุกอยางถูกตองดีแลวก็ใหเราทําการคลิกที่ปุม Finish เพื่อจะเขาหนาจอ text editor สําหรับเขียน
โปรแกรมตอไป หนาจอที่เกิดขึ้นใหมหลังการกดปุม Finish แสดงไดดังรูปตอไปนี้ (ถาเรากดปุม Next โปรแกรม
จะใหเราเลือก paltform และ MCU ที่เราจะใชในการซิมมูเลตและ  debug โปรแกรม ตอไป) 
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รูปแสดง หนาจอที่เกิดขึ้นหลังการกดปุม Finish  
 

 จากรูปขางบน จะประกอบไปดวยหนาตาง Work space ซึ่งมีไวสําหรับจัดการกับไฟลในโปรเจ็กตเชน
การ Add existing file, Remove File หรือ การ Set as Entry File เปนตน สวนหนาตางถัดมาคือ Text Editor มี
ไวสําหรับใหเราเขียนโปรแกรมลงไป และสุดทายเปนหนาตาง Output ที่ทําหนาที่แสดงขอความบอกใหเราทราบ
ถึงผลจากการคอมไฟลโปรแกรม ซึ่งหากทานไมพบหนาตางทั้งสามนี้ทานสามารถเปดมันขึ้นมาไดเอง โดยการ
เขาไปเลือกที่เมนู View  
 เมื่อเราทําการเขียนโปรแกรมลงไปที่ text editor เรียบรอยแลวก็ใหทําการบันทึกไฟลโดยการเลือกไปที่
เมนู File>save และทําการคอมไพลโปรแกรมโดยการกดปุม F7 หรือเลือกที่เมนู Project>Build หากเราเขียน
โปรแกรมถูกตอง โปรแกรมจะไมฟอง Error ที่หนาตาง Output แตหากเขียนโปรแกรมไมถูกตองมันจะฟอง Error 
หรือ Warning ก็ใหเราแกไขมันใหถูกตองและทําการคอมไพลใหมซึ่งจะทําใหไดไฟล rs232.aps, rs232.hex, 
rs232.lst, rs232.map, rs232.asm และ rs232.obj ขึ้นมา หากเราไมตองการไฟล .map และ .lst ใหเราเขาไปที่
เมนู Project>AVR Asembler Setup จากนั้นจะพบหนาตาง AVRAssembler  ใหเราคลิกเอาเครื่องหมายถูกที่
ชอง Map File กับ Lst File ออกและจากนั้นก็กดปุม Ok ก็เปนอันเสร็จส้ิน สําหรับไฟลนามสกุลตางๆ ดังที่เรา
กลาวมาขางตนทานสามารถเปดเขาไปดูเนื้อหาขางในไฟลไดดวยการเลือกไปที่เมนู File>Open File จากนั้นก็
เลือกไฟลที่ทานตองการเปดและกดปุม Open 

Work space Text Editor 

Output 
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     รูปแสดง หนาตาง AVRAssembler  
 

การเปดไฟลโปรเจ็กตและไฟลแอสเซมบลี 
 เมื่อเราตองการเปดโปรแกรมที่มีอยูแลวขึ้นมาแกไขเราสามารถทําไดโดยการคลิกเมนู Project>Open 
Project เพื่อเปนการเปดไฟลโปรเจ็กต(*.aps) หลังจากที่เราเปดไฟลโปรเจ็กตแลวจากนั้นก็คลิกเลือกไปที่
โฟลเดอร Assembler ที่อยูในหนาตาง Work space เราจะพบไฟล .asm ที่เราตองการแกไขอยูในนั้น แตถาหาก
เราเปดไฟลโดยใชเมนู File>Open File เราก็สามารถที่จะเปดไฟล .asm(หรือไฟลอื่นๆ ที่ text editor รองรับ) ได
เชนเดียวกัน แตเราจะไมสามารถทําการคอมไพลมันได เปนไดแตเพียงการแกไขและบันทึกเทานั้น อยางไรก็ตาม
การเปดไฟลโปรเจ็กต(*.aps) ดวยเมนู File>Open File นี้ก็สามารถทําไดและใหผลการทํางานเชนเดียวกับการ
เปดมันดวยเมนู Project>Open Project 
 
การ Add existing File, Remove File และ Set as Entry File 
 Add existing File ก็คือการเพิ่มไฟล .asm เขามาในโปรเจ็กต โดยเราสามารถทําได 2 วิธีดวยกันคือ
การเลือกไปที่เมนู Project>Add existing File จากนั้นก็ใหเราเลือกไฟล .asm ที่เราตองการนําเขามา สวนอีกวิธี
หนึ่งทําไดโดยการคลิกเมาสปุมขวาไปที่โฟลเดอร Assembler ที่อยูในหนาตาง Work space จากนั้นเราจะเห็น
หนาตางออปชั่นเล็กๆ ปรากฏขึ้นมาก็ใหเราเลื่อนเมาสไปคลิกเลือกที่ Add existing File จะทําใหเราสามารเลือก
ไฟล .asm ที่เราตองการได  
 Remove File จะทํางานตรงกันขามกับ Add existing File นั่นคือมันจะลบไฟล .asm ที่เราไมตองการ
ออกจากโปรเจ็กตไฟลของเรา เราสามารถ Removeไฟลไดโดยการคลิกเมาสปุมขวาเลือกไปที่ไฟลที่เราตองการ
ลบ จากนั้นจะปรากฏหนาตางขึ้นมาใหเราเลือกไปที่ Remove File form Project เพียงเทานี้ไฟลที่เราเลือกมันก็
จะถูกลบออกไปจากโปรเจ็กตที่เรากําลังทํางานอยู 
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 Set as Entry File จะเปนการเลือกไฟล .asm ที่อยูในโปรเจ็กตไฟลขณะนั้นใหมันพรอมที่จะถูก
คอมไพล ฟงกชั่นนี้จะมีความจําเปนมากเมื่อเรามีไฟล .asm หลายไฟลอยูในโปรเจ็กตเดียวกัน ซึ่งโปรแกรม 
Astudio4 นี้จะไมทําการคอมไพลไฟล .asm ทั้งหมดพรอมกัน แตจะเลือกคอมไพลเฉพาะไฟลที่โดน Set as 
Entry File เทานั้น เราสามารถรูไดวาไฟล .asm ตัวใดที่ถูก set ไวโดยการสังเกตไอคอนที่อยูหนาชื่อไฟลจะมีรูป
ลูกศรสีแดงหันหัวลงดังนี้  หรือดูไดจากรูปนี้  

 
รูปแสดง หนาจอที่เกิดจากการ Add existing File และหนาตาง Output ที่รายงานผลการ
คอมไพลโปรดสังเกตการ Warning (วงกลมสีเหลือง) ตางๆดวย ถึงแมการคอมไพลไมผิด
พลาดแตอาจจะมีผลตอการทํางานของ CPU ได 
 

สําหรับการ Set as Entry File สามารถทําไดโดยการคลิกเมาสปุมขวาเลือกไปที่ชื่อไฟลที่เราตองการ
คอมไพลจากนั้นจะปรากฏเมนูเล็กๆ ขึ้นมาใหเราเลือกไปที่ Set as Entry File ก็เปนอันเสร็จ 
 เราควรจําไวอยางหนึ่งวาหลังการคอมไพลแลวไมวาเราจะทําการคอมไพลไฟล .asm ตัวใดก็ตามในโปร
เจ็กตนั้น ไฟลเอาพุตที่โปรแกรมสรางขึ้นมานั้นจะมีชื่อตามชื่อไฟลโปรเจ็กตนั้นเสมอ มันจะไมมีชื่อไฟลตามไฟล 
.asm ที่ถูกคอมไฟล ดังนั้นเพื่อปองกันการสับสนทานอาจจะใหมีเพียงไฟล .asm เพียงไฟลเดียวอยูในไฟลโปร
เจ็กตแตละโปรเจ็กตก็ไดและตั้งชื่อใหทั้งสองไฟลนี้ตรงกัน 
 อีกอยางหนึ่งที่เราอยากจะใหทานสังเกต นั่นก็คือผลที่ไดจากการคอมไพลในแตละครั้งวาเปนเชนไรบาง
เชน ขนาดของไฟลที่คอมไพลไดมีขนาดเทาไรซึ่งบางทีเราเขียนโปรแกรมเพลินมันอาจจะมีขนาดโตกวาหนวย
ความจําที่จะเก็บมันก็ได หรือที่สําคัญอีกอยางหนึ่งก็คือขอความ Warning ที่โปรแกรมเตือนดังนี้ 
“C:\My Documents\avr\rs232.asm(92): warning: A .db segment with an odd number of bytes is 
detected. A zero byte is added.”  
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 หากทานใดเคยเลน AVR และใชฟงกชั่นที่เกี่ยวกับพอรตอนุกรม RS232 คงพอจะทราบดีวาบางครั้ง 
AVR มันก็ไมสามารถแสดงขอความที่อยูหลังบรรทัดนี้(บรรทัดที่แสดงขอความ Warning) ตอไปได ทั้งที่ขอความ
ยังไมส้ินสุด นั่นเปนเพราะวามันจะทําการเขียนขอมูลลงหนวยความจําโปรแกรมเปนทีละ word(2 ไบต) ดังนั้น
เมื่อขอความที่เราตองการจะเขียนลงบนหนวยความจํามันมีจํานวนเปนเลขคี่ มันก็จะเพิ่มเลข 0 เขาไปทายขอ
ความในบรรทัดนั้นๆ เพื่อใหครบจํานวนเปนเลขคูเสมอ  ทีนี้เมื่อเราเขียนโปรแกรมใหตรวจสอบขอความวาถาพบ
เลข  0 เมื่อใดก็ใหถือวาส้ินสุดขอความทันที ดังนั้นเมื่อโปรแกรมทําการอานและตรวจสอบขอมูลมาถึงไบตที่ 
AVR เพิ่มเลข 0 ขึ้นมาเอง โปรแกรมก็เขาใจวาเราตองการสิ้นสุดขอความที่บรรทัดนี้ดังนั้นจึงทําใหขอความที่
เหลือไมถูกตรวจพบนั่นเอง และวิธีแกงายๆ นั่นก็คือใหเราเพิ่มอักขระอะไรก็ไดเขาไปอีกตัวหนึ่งในบรรทัดนี้ยกเวน
เลข 0 เทานี้ก็สามารถแกการ warining ตรงนี้ได(เลข 0 ที่เรากําลังพูดถึงกันอยูขณะนี้ไมใชเลข “0” ที่เปนรหัส 
ASCII นะครับหากแตเปนเลข 0 ที่เปนเซตของเลขจํานวนเต็ม) 
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รูปวงจร CP-AVR V3.0/V3.0EXP 
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รูปวงจร CP-AVR V4.0 
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รูปวงจร CP-AVR V4.0 (ตอ) 
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